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          Adobe Acrobat Reader 

Finding Words

You can use the Find command to find a complete word or part of a word in the current PDF 
document.  Acrobat Reader looks for the word by reading every word on every page in the file, 
including text in form fields.

To find a word using the Find command:

1. Click the Find button (Binoculars), or choose Edit > Find.
2. Enter the text to find in the text box.
3. Select search options if necessary:

Match Whole Word Only finds only occurrences of the complete word you enter in 
the box.  For example, if you search for the word stick, the words tick and sticky will 
not be highlighted.

Match Case finds only words that contain exactly the same capitalization you enter in 
the box.

Find Backwards starts the search from the current page and goes backwards through 
the document.

4. Click Find.  Acrobat Reader finds the next occurrence of the word.
       
To find the next occurrence of the word, Do one of the following:
           
            Choose Edit > Find Again 
            Reopen the find dialog box, and click Find Again. 
            (The word must already be in the Find text box.)

Copying and pasting text and graphics to another application

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 
into another application such as a word processor.  You can also paste text into a PDF 
document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 
can switch to another application and paste it into another document.  

Note:  If a font copied from a PDF document is not available on the system displaying the 
copied text, the font cannot be preserved.  A default font  is substituted.
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To select and copy it to the clipboard:
1. Select the text tool T, and do one of the following:

       To select a line of text, select the first letter of the sentence or phrase and drag to
       the last letter.  

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 
(Mac OS) as you drag across the width of the document. 
       
To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 
(Mac OS) as you drag the length of the document.
        
To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 
on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 
in the document is selected.  When you release the mouse button, the selected text is 
highlighted.  To deselect the text and start over, click anywhere outside the selected text.  
The Select All command will not select all the text in the document.  A workaround for this 
(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 
text to the clipboard.

2. To view the text, choose Window > Show Clipboard

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 
Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 
Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 
Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK.
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1 [REPORT OF ACTION TAKEN IN CLOSED SESSION

2 ON TUESDAY, NOVEMBER 5, 2013, ON PAGE 77]

3

4

5

6 SUP. RIDLEY-THOMAS, CHAIRMAN: GOOD MORNING. (GAVEL) WE WELCOME 

7 YOU TO THE REGULARLY SCHEDULED BOARD OF SUPERVISORS MEETING. 

8 TODAY IS TUESDAY NOVEMBER THE FIFTH. WE TAKE NOTE OF THE FACT 

9 THAT THE SERGEANT AT ARMS IS IN PLACE, PAUL COBLENTZ. OUR 

10 CHIEF EXECUTIVE OFFICER, WILLIAM T FUJIOKA. OUR COUNTY COUNSEL 

11 IS JOHN KRATTLI AND OUR EXECUTIVE OFFICER IS SACHI HAMAI. I 

12 TAKE NOTE OF THE FACT THAT THERE IS A QUORUM THAT IS PRESENT, 

13 AND WE PROCEED WITH THIS MORNING'S INVOCATION, ROSHI WENDY 

14 NAKAO WHO IS THE ABBOT, ZEN CENTER OF LOS ANGELES, BUDDHIST 

15 ESSENCE TEMPLE, AT THE INVITATION OF THE CHAIR. OUR PLEDGE 

16 VETERAN IS HERE AT THE INVITATION OF SUPERVISOR GLORIA MOLINA 

17 AND HE IS JOSE A. HUANTE, WHO IS A MEMBER OF POST NO. 10218, 

18 VETERANS OF FOREIGN WARS OF THE UNITED STATES OF AMERICA IN EL 

19 MONTE. SO IF YOU WOULD PLEASE RISE THIS MORNING FOR THIS 

20 MORNING'S INVOCATION. 

21

22 ROSHI WENDY EGYOKU NAKAO: AS WE GATHER HERE THIS MORNING, LET 

23 US OPEN OURSELVES TO LEARNING NEW WAYS OF COOPERATING AND 

24 COLLABORATING. MAY WE YIELD ALL BIASES AND JUDGMENTS THAT KEEP 

25 US FROM LISTENING TO EACH OTHER AND FROM SEEING THE WIDER WEB 
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1 OF LIFE. LET US STAND BRAVELY IN THE OPEN SPACE OF NOT KNOWING 

2 AND SEE CLEARLY ALL THE MANY INGREDIENTS OF SITUATIONS. MAY 

3 LOVING ACTIONS ARISE FROM OUR WISE AND RECEPTIVE HEARTS. LET 

4 US EMBRACE THE DIVERSITY OF THE COUNTY OF LOS ANGELES BY 

5 KNOWING THAT DIVERSITY IS THE NATURAL EXPRESSION OF LIFE 

6 ITSELF, NOT A PROBLEM OR POINT OF CONTENTION UNLESS WE, IN 

7 IGNORANCE, MAKE IT SO. LET US USE OUR GIFTS FREELY IN THE 

8 SERVICE OF OUR NEIGHBORS AND IN THE STEWARDSHIP OF THE 

9 ENVIRONMENT. MAY EVERYONE KNOW INTIMATELY THE WHOLENESS OF 

10 THEIR BEING, SENDING LOVE EVERYWHERE, FILLING THE SMALLEST 

11 PARTICLE TO THE LARGEST SPACE, TO THIS VERY MOMENT THAT WE 

12 SHARE, AS A TRUE COMMUNITY OF BEINGS, WITH THE EARTH, ITS 

13 CREATURES AND ALL OF ITS RESOURCES. MAY WE BE GENEROUS AND 

14 KIND, CARE FOR EACH OTHER AS OURSELVES, AND ENSURE THAT 

15 EVERYONE'S POTENTIAL IS FULLY REALIZED. LET US SEE AS 

16 OURSELVES ALL THE PEOPLE IN THIS GREAT COUNTY OF LOS ANGELES, 

17 THOSE WITHOUT FOOD, WITHOUT A HOME, WITH MENTAL ILLNESS, 

18 VETERANS IN NEED, AND ALL THE MYRIAD FORMS OF SUFFERING THAT 

19 UNFOLD WITHIN THIS HUMAN SPHERE. MAY OUR LOVE MANIFEST IN 

20 SIMPLE ACTS OF CARING, IN WORDS THAT GRATIFY THE HEART, IN 

21 DECISIONS AND POLICIES THAT SERVE THE MOST VULNERABLE AMONG 

22 US, IN ENDING THE SUFFERING OF THOSE IN NEED. LET US REJOICE 

23 IN THE WISDOM AND COMPASSION THAT IS AVAILABLE TO US ALL. MAY 

24 IT MANIFEST IN OUR RESPONSIVENESS TO OUR CONSTITUENTS AND IN 

25 SUCCESSFUL COLLABORATIONS WITH OUR GOVERNMENTAL COLLEAGUES. 
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1 LET US APPRECIATE THE MANY HANDS AND EYES OF THOUSANDS OF LOS 

2 ANGELES COUNTY EMPLOYEES WHO ALLOW THE BOARD OF SUPERVISORS TO 

3 CARRY OUT THEIR WORK. LET US VALUE THEIR CONTRIBUTIONS AND 

4 SINCERELY ACKNOWLEDGE THEIR SUPPORT. LET US APPRECIATE THE 

5 MEMBERS OF THE BOARD OF SUPERVISORS. MAY THEY CHANNEL LOVE, 

6 WISDOM AND GENEROSITY INTO SELFLESS ACTIONS THAT BENEFIT 

7 EVERYONE, INCLUDING PEOPLE THEY MAY NEVER KNOW OR SEE AND THE 

8 GENERATIONS YET TO COME. LET US FIND OUR HOME IN THE AWARENESS 

9 OF EACH MOMENT. MAY WE BE PRESENT TO OURSELVES AND TO EACH 

10 OTHER MOMENT AFTER MOMENT. NOW, LET US BE SILENT. LET US 

11 LISTEN. MAY OUR WORDS AND ACTIONS SOW NO FEAR. LET US BEGIN 

12 ANEW WITH EACH AND EVERY BREATH. MAY WE ALTOGETHER BE AS ONE 

13 BODY AND SERVE EACH OTHER GENEROUSLY SO THAT ALL BEINGS ARE 

14 FREE OF SUFFERING, ALL BEINGS LIVE IN HARMONY, EVERYONE HAS 

15 ENOUGH, DEEP WISDOM IS REALIZED AND COMPASSION FLOWS 

16 UNHINDERED. MAY THE VISION OF A JUST AND CARING WORLD BE 

17 FULFILLED AND SECURITY AND PROSPERITY BE MADE AVAILABLE TO 

18 EVERYONE. 

19

20 JOSE A. HUANTE: PLEASE JOIN ME IN THE PLEDGE OF ALLEGIANCE. 

21 [PLEDGE OF ALLEGIANCE RECITED.] 

22

23 JOSE A. HUANTE: THANK YOU. 

24
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1 SUP. RIDLEY-THOMAS, CHAIRMAN: LADIES AND GENTLEMEN, MEMBERS OF 

2 THE BOARD, I'M PLEASED TO PRESENT THIS MORNING'S INVOCATOR, 

3 ROSHI WENDY EGYOKU NAKAO, WHO HAS SERVED AS THE ABBOTT AND 

4 HEAD TEACHER OF THE ZEN CENTER OF LOS ANGELES SINCE 1999. 

5 SINCE ITS FOUNDING IN IN 1967, THE ZEN CENTER OF LOS ANGELES 

6 HAS PROVIDED THE TEACHINGS AND PRACTICE OF ZEN BUDDHISM TO ALL 

7 WHO DESIRE TO LEARN. SHE FIRST ENCOUNTERED ZEN PRACTICE IN 

8 1975 WHEN SHE DID A SEVEN-DAY ZEN MEDITATION SESSION ON DARE. 

9 HOWEVER, FOLLOWING THIS PLUNGE, SHE DEVOTED HER LIFE TO THE 

10 PATH OF THE TEACHINGS OF THE BUDDHA. ROSHI NAKAO GREW UP IN 

11 HAWAII IN A FAMILY OF JAPANESE AND PORTUGUESE ANCESTRY. SHE 

12 ATTENDED THE UNIVERSITY OF WASHINGTON-SEATTLE WHERE SHE EARNED 

13 DEGREES IN EAST ASIAN STUDIES AND LIBRARY SCIENCE. SHE'S A 

14 FOUNDING MEMBER OF THE ZEN PEACE MAKER COMMUNITY AND COEDITOR 

15 OF "APPRECIATE YOUR LIFE" ON "ZEN PRACTICE, BODY BREATH AND 

16 MIND," AND "THE HAZY MOON OF ENLIGHTENMENT." SO TODAY WE'D 

17 LIKE TO EXTEND OUR APPRECIATION TO YOU FOR HELPING US TO BEGIN 

18 THIS DAY WITH HOPE AND REFLECTION. AND IT'S ON BEHALF OF THE 

19 ENTIRE BOARD OF SUPERVISORS THAT WE PRESENT YOU WITH THIS 

20 CERTIFICATE OF APPRECIATION. [APPLAUSE.] SUPERVISOR MOLINA, 

21 PLEASE? 

22

23 SUP. MOLINA: THANK YOU SO MUCH. MR. CHAIRMAN AND MEMBERS, IT 

24 IS INDEED MY HONOR THIS MORNING TO PRESENT TO YOU AND WELCOME 

25 JOSE HUANTE. HE REPRESENTS THE VETERANS OF FOREIGN WARS POST 
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1 10218 OF EL MONTE. JOSE IS A LONGTIME EL MONTE RESIDENT AND 

2 ONE OF THE DISTRICT'S MOST DEVOTED VOLUNTEERS. JOSE AND HIS 

3 WIFE, MARIA, HAVE CHOSEN TO SPEND THEIR RETIREMENT 

4 VOLUNTEERING COUNTLESS HOURS FOR AMIGOS DE LOS RIOS, TENDING, 

5 WEEDING AND CARING FOR OUR EMERALD NECKLACE PARKS THROUGHOUT 

6 THE AREA. THEY ARE ALSO STAUNCH SUPPORTERS OF CREATING A 

7 NATIONAL DESIGNATION STATUS FOR OUR BEAUTIFUL SAN GABRIEL 

8 MOUNTAINS. JOSE SERVED DURING THE GULF WAR AS A STAFF SERGEANT 

9 WITH THE UNITED STATES RESERVES. HIS NUMEROUS COMMENDATIONS 

10 INCLUDE A NATIONAL DEFENSE SERVICE MEDAL AN ARMED FORCES 

11 RESERVE MEDAL, AN ARMY RESERVE COMPONENT ACHIEVEMENT MEDAL AND 

12 A SOUTHWEST SERVICE MEDAL WITH A BRONZE STAR. WE EXTEND OUR 

13 GRATITUDE FOR HIS HONORABLE MILITARY SERVICE AND ALSO THE 

14 COMMUNITY SERVICE THAT HE IS SO DEVOTED TO, INCLUDING HE AND 

15 HIS WIFE. CONGRATULATIONS, MR. HUANTE, THANK YOU. IT'S AN 

16 HONOR. [APPLAUSE.] 

17

18 SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK BOTH THE MORNING'S 

19 INVOCATOR AND THE PLEDGE VETERAN. WE NOW TURN TO OUR AGENDA. 

20 GOOD MORNING, MADAME EXECUTIVE OFFICER. IF WE CAN PROCEED 

21 ACCORDINGLY. 

22

23 SACHI HAMAI, EXEC. OFFICER: GOOD MORNING, MR. CHAIRMAN, 

24 MEMBERS OF THE BOARD. WE WILL BEGIN TODAY'S AGENDA ON PAGE 2, 

25 PRESENTATIONS AND SET MATTERS. ON ITEM S-1, AS INDICATED ON 
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1 THE POSTED AGENDA, THE DIRECTOR OF CHILDREN AND FAMILY 

2 SERVICES REQUESTS THAT THIS ITEM BE CONTINUED TO DECEMBER 3, 

3 2013. AND ALSO ON THIS ITEM, THERE'S A REQUEST FROM A MEMBER 

4 OF THE PUBLIC TO HOLD IT. ON PAGE 3, AGENDA OF THE MEETING OF 

5 THE COMMUNITY DEVELOPMENT COMMISSION, ON ITEM NO. 1-D, THERE'S 

6 A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON 

7 PAGE 4, AGENDA FOR THE MEETING OF THE HOUSING AUTHORITY, ITEM 

8 1-H. THAT ITEM IS BEFORE YOU. 

9

10 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. SUPERVISOR 

11 MOLINA MOVES. SUPERVISOR ANTONOVICH SECONDS. I NOTE NO 

12 OBJECTIONS, THEREFORE PLEASE RECORD A UNANIMOUS VOTE. 

13

14 SACHI HAMAI, EXEC. OFFICER: ON PAGE 5, AGENDA FOR THE MEETING 

15 OF THE REGIONAL PARK AND OPEN SPACE DISTRICT, ITEM NO. 1-P, 

16 THAT ITEM IS BEFORE YOU. 

17

18 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. SUPERVISOR 

19 YAROSLAVSKY MOVES. SUPERVISOR KNABE SECONDS. SEEING NO 

20 OBJECTIONS, PLEASE RECORD A UNANIMOUS VOTE. 

21

22 SACHI HAMAI, EXEC. OFFICER: ON PAGE 6, BOARD OF SUPERVISORS 

23 ITEMS 1 THROUGH 15, ON ITEM NO. 1, THERE'S A REQUEST FROM A 

24 MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 2, 

25 SUPERVISOR RIDLEY-THOMAS AND SUPERVISOR ANTONOVICH ABSTAIN 
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1 FROM THE VOTE. ON ITEM NO. 4, THIS INCLUDES SUPERVISOR 

2 ANTONOVICH'S RECOMMENDATION AS INDICATED ON THE POSTED AGENDA. 

3 ON ITEM NO. 10, AS INDICATED ON THE SUPPLEMENTAL AGENDA, 

4 SUPERVISOR RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED 

5 THREE WEEKS TO NOVEMBER 26, 2013. AND ON THIS ITEM, THERE'S A 

6 REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD IT. ON ITEM NO. 11, 

7 AS INDICATED ON THE SUPPLEMENTAL AGENDA, SUPERVISOR RIDLEY-

8 THOMAS REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO 

9 NOVEMBER 19, 2013. THERE IS ALSO A REQUEST FROM A MEMBER OF 

10 THE PUBLIC TO HOLD THE ITEM. ON ITEM NO. 12, SUPERVISOR 

11 RIDLEY-THOMAS REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO 

12 NOVEMBER 12, 2013. THE REMAINING ITEMS UNDER THE CONSENT 

13 CALENDAR ARE BEFORE YOU. 

14

15 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU. WITH THOSE 

16 EXCEPTIONS OF THE ABSTENTIONS HAVING BEEN INDICATED, AND THAT 

17 WOULD HAVE BEEN ITEM NO.? 

18

19 SACHI HAMAI, EXEC. OFFICER: 2? 

20

21 SUP. RIDLEY-THOMAS, CHAIRMAN: ITEM NO. 2, PLEASE RECORD THE 

22 APPROPRIATE VOTE, SEEING NO OBJECTIONS ON THE BALANCE OF THE 

23 AGENDA. 

24
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1 SACHI HAMAI, EXEC. OFFICER: THANK YOU. ON PAGE 13, CONSENT 

2 CALENDAR, ITEMS 16 THROUGH 45. ON ITEM NO. 17, AS INDICATED ON 

3 THE SUPPLEMENTAL AGENDA, THE DIRECTOR OF THE DEPARTMENT OF 

4 CHILDREN AND FAMILY SERVICES REQUESTS THAT THIS ITEM BE 

5 CONTINUED TWO WEEKS TO NOVEMBER 19, 2013. AND THERE'S ALSO A 

6 REQUEST FROM MEMBERS OF THE PUBLIC TO HOLD IT. ON ITEMS NO. 

7 18, 19, 20, 21, 22 AND 23, THERE'S A REQUEST FROM A MEMBER OF 

8 THE PUBLIC TO HOLD THESE ITEMS. ON ITEM NO. 25, SUPERVISOR 

9 YAROSLAVSKY REQUESTS THAT THIS ITEM BE CONTINUED TWO WEEKS TO 

10 NOVEMBER 19, 2013. AND ON THIS ITEM, THERE'S ALSO A REQUEST 

11 FROM A MEMBER OF THE PUBLIC TO HOLD THIS ITEM. ON ITEM NO. 31, 

12 THERE'S A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD THIS 

13 ITEM. ON ITEM NO. 32, SUPERVISOR KNABE AND A MEMBER OF THE 

14 PUBLIC REQUEST THAT THIS ITEM BE HELD. ON ITEM NO. 36, THE 

15 FIRE CHIEF REQUESTS THAT THIS ITEM BE CONTINUED ONE WEEK TO 

16 NOVEMBER 12, 2013. AND ON THIS ITEM, THERE'S ALSO A REQUEST 

17 FROM A MEMBER OF THE PUBLIC TO HOLD IT. THAT WAS 36. ON ITEM 

18 NO. 40, AS INDICATED ON THE SUPPLEMENTAL AGENDA, THE SHERIFF 

19 REQUESTS THAT THIS ITEM BE REFERRED BACK TO HIS DEPARTMENT. 

20 THERE IS ALSO A REQUEST FROM A MEMBER OF THE PUBLIC TO HOLD 

21 THIS ITEM. THE REMAINING ITEMS UNDER THE CONSENT CALENDAR ARE 

22 BEFORE YOU. 

23



November 5, 2013

11

1 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. SUPERVISOR 

2 KNABE MOVES. SUPERVISOR ANTONOVICH SECONDS. SEEING NO 

3 OBJECTIONS, PLEASE RECORD A UNANIMOUS VOTE. 

4

5 SACHI HAMAI, EXEC. OFFICER: ON PAGE 27, ORDINANCES FOR 

6 INTRODUCTION, ITEMS 46 THROUGH 54. AND I'LL READ THE SHORT 

7 TITLE IN FOR THE RECORD ON THESE ITEMS. ON ITEM NO. 46, THIS 

8 IS AN ORDINANCE FOR INTRODUCTION TO EXTEND THE SUNSET REVIEW 

9 DATE FOR THE CONSUMER AFFAIRS ADVISORY COMMISSION TO JUNE 30, 

10 2017. THIS ITEM IS BEFORE YOU. 

11

12 SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR ANTONOVICH MOVES. 

13 SUPERVISOR MOLINA SECONDS. I SEE NO OBJECTIONS, THEREFORE 

14 PLEASE RECORD A UNANIMOUS VOTE. 

15

16 SACHI HAMAI, EXEC. OFFICER: ON ITEM NO. 47, THIS IS AN 

17 ORDINANCE FOR INTRODUCTION TO EXTEND THE SUNSET REVIEW DATE 

18 FOR THE LOS ANGELES HISTORICAL LANDMARK AND RECORDS COMMISSION 

19 TO JUNE 30, 2018, AND THE COMMISSION TO OBTAIN BOARD APPROVAL 

20 ON COMMISSIONS MEETING FREQUENCY. THE ITEM IS BEFORE YOU. 

21

22 SUP. RIDLEY-THOMAS, CHAIRMAN: THE ITEM IS BEFORE US. 

23 SUPERVISOR YAROSLAVSKY MOVES, SUPERVISOR KNABE SECONDS. SEEING 

24 NO OBJECTIONS, PLEASE RECORD A UNANIMOUS VOTE. 

25
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1 SACHI HAMAI, EXEC. OFFICER: ON ITEM NO. 48, THIS IS AN 

2 ORDINANCE FOR INTRODUCTION AMENDING THE COUNTY CODE, TITLE 6, 

3 SALARIES RELATING TO THE ADDITION, DELETION AND CHANGING OF 

4 CERTAIN CLASSIFICATIONS AND NUMBER OF ORDINANCE POSITIONS IN 

5 THE DEPARTMENT OF HEALTH SERVICES. THIS ITEM IS BEFORE YOU. 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. SUPERVISOR MOLINA 

8 MOVES. SUPERVISOR YAROSLAVSKY SECONDS. SEEING NO OBJECTIONS, 

9 PLEASE RECORD A UNANIMOUS VOTE ON ITEM NO. 48. 

10

11 SACHI HAMAI, EXEC. OFFICER: ON AGENDA ITEMS NO. 49 THROUGH 54, 

12 THESE ARE ORDINANCES FOR INTRODUCTION AMENDING COUNTY CODES 

13 TITLE 26, BUILDING CODE, TITLE 27, ELECTRICAL CODE, TITLE 28, 

14 PLUMBING CODE, TITLE 29, MECHANICAL CODE, TITLE 30, 

15 RESIDENTIAL CODE, AND TITLE 31, GREEN BUILDINGS STANDARDS CODE 

16 TO REPEAL, AMEND AND/OR REPLACE THEM WITH PROVISIONS 

17 INCORPORATING PORTIONS OF THE 2013 CALIFORNIA CODES SET 

18 NOVEMBER 26, 2013 FOR HEARING ON ADOPTION OF THE PROPOSED 

19 CODES. THESE ITEMS ARE BEFORE YOU. 

20

21 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. SUPERVISOR 

22 KNABE MOVES. SUPERVISOR ANTONOVICH SECONDS ON THE ITEMS SO 

23 INDICATED, THEREFORE RECORD A UNANIMOUS VOTE. 

24
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1 SACHI HAMAI, EXEC. OFFICER: ON PAGE 30, SEPARATE MATTERS, ITEM 

2 55, AND AGAIN I'LL READ THE SHORT TITLE IN FOR THE RECORD. 

3 THIS IS THE TREASURER AND TAX COLLECTOR'S RECOMMENDATION TO 

4 ADOPT A RESOLUTION AMENDING A PRIOR RESOLUTION ADOPTED BY THE 

5 BOARD ON AUGUST 20, 2013, AUTHORIZING AN INCREASE IN THE 

6 MAXIMUM AGGREGATE PRINCIPAL AMOUNT OF THE CONTRACTUAL 

7 ASSESSMENT LIMITED OBLIGATION IMPROVEMENT BOND SERIES 2013 C-2 

8 FROM $6 MILLION TO $7 MILLION ON BEHALF OF NEW PROPERTY OWNER 

9 HILLCREST REAL ESTATE L.L.C. THIS ITEM IS BEFORE YOU. 

10

11 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. SUPERVISOR ANTONOVICH 

12 MOVES. SUPERVISOR MOLINA SECONDS. THERE ARE NO OBJECTIONS, 

13 THEREFORE RECORD A UNANIMOUS VOTE ON ITEM NO. 55, PLEASE. 

14

15 SACHI HAMAI, EXEC. OFFICER: DISCUSSION ITEMS, ITEMS 56 AND 57, 

16 ON ITEM NO. 56, WE WILL HOLD FOR A DISCUSSION. ON ITEM NO. 57, 

17 AS INDICATED ON THE POSTED AGENDA, THE CHIEF EXECUTIVE OFFICER 

18 AND THE DIRECTOR OF HEALTH SERVICES REQUEST THAT THIS ITEM BE 

19 CONTINUED TO DECEMBER 3, 2013. ON PAGE 31, MISCELLANEOUS 

20 ADDITIONS TO THE AGENDA WHICH WERE POSTED MORE THAN 72 HOURS 

21 IN ADVANCE OF THE MEETING AS INDICATED ON THE SUPPLEMENTAL 

22 AGENDA, ITEM NO. 58 IS BEFORE YOU-- 58-A, EXCUSE ME. THAT ITEM 

23 IS BEFORE YOU. 

24
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1 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU VERY MUCH. 

2 YAROSLAVSKY MOVES AND I'LL BE SECONDS. PLEASE RECORD A 

3 UNANIMOUS VOTE ON 58. 

4

5 SACHI HAMAI, EXEC. OFFICER: AND 58-B IS BEFORE YOU. 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR MOLINA MOVES. AND 

8 THEN SUPERVISOR ANTONOVICH SECONDS. PLEASE RECORD A UNANIMOUS 

9 VOTE. 

10

11 SACHI HAMAI, EXEC. OFFICER: AND THAT COMPLETES THE READING OF 

12 THE AGENDA. BOARD OF SUPERVISORS SPECIAL ITEMS BEGIN WITH 

13 SUPERVISORIAL DISTRICT NO. 3. 

14

15 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHTY. ON BEHALF OF ALL 

16 MEMBERS OF THE BOARD, LET ME SIMPLY ASK THOSE WHO ARE 

17 PARTICIPATING IN THE VETERANS DAY SCROLL PRESENTATION, IF YOU 

18 WOULD COME FORWARD. THIS IS AN OPPORTUNITY TO ACKNOWLEDGE 

19 LIEUTENANT COLONEL PATRICIA JACKSON-KELLEY, UNITED STATES 

20 ARMY, RETIRED. LADIES AND GENTLEMEN, WITH REFLECTIVE HEARTS 

21 AND A SINCERE DEMONSTRATION OF GRATITUDE AND PATRIOTISM, WE 

22 PAUSE EACH YEAR ON NOVEMBER 11TH TO SALUTE, HONOR AND REMEMBER 

23 OUR NATION'S MILITARY VETERANS WHO BRAVELY SACRIFICE FOR THE 

24 RIGHTS AND LIBERTIES OF ALL PEOPLE. VETERANS DAY, INITIALLY 

25 OBSERVED AS ARMISTICE DAY, WAS DECLARED TO HONOR SOLDIERS WHO 
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1 FOUGHT AND SERVED WITH DISTINCTION AND VALOR. ON THIS, THE 

2 95TH ANNIVERSARY OF ARMISTICE DAY, RECOGNIZED AS VETERANS DAY 

3 SINCE 1954, WE NOT ONLY PAY HOMAGE TO THE FALLEN, THE WOUNDED, 

4 THE MISSING AND THE FAMILIES, BUT WE PAY TRIBUTE TO THOSE WHO 

5 CONTINUE TO DEFEND FREEDOM AGAINST TYRANNY WHENEVER AND 

6 WHEREVER IT IS THREATENED. THE BOARD OF SUPERVISORS OF THE 

7 COUNTY OF LOS ANGELES WANTS TO HEREBY RECOGNIZE NOVEMBER THE 

8 11TH OF THIS YEAR AS VETERANS DAY AND ENCOURAGE ALL CITIZENS 

9 TO PARTICIPATE IN SPECIAL SERVICES, PROGRAMS AND CEREMONIES 

10 THAT HONOR OUR VETERANS. IT IS WITH GREAT PLEASURE THAT I 

11 PRESENT THIS SCROLL DECLARING VETERANS DAY TO COLONEL PATRICIA 

12 JACKSON-KELLEY. SHE SERVED PROUDLY IN THE UNITED STATES ARMY 

13 FROM 1985 UNTIL 2003 AND ALSO SERVED AS A CAPTAIN IN THE 

14 UNITED STATES AIR FORCE. COLONEL JACKSON-KELLEY IS CURRENTLY A 

15 WOMAN'S VETERAN OUTREACH COORDINATOR WITH THE AMERICAN LEGION 

16 AND IS THE SECOND DISTRICT APPOINTEE FOR THE LOS ANGELES 

17 COUNTY VETERANS ADVISORY COMMISSION. SHE RECEIVED A NUMBER OF 

18 AWARDS AND COMMENDATIONS, INCLUDING A U.S. AIR FORCE 

19 OUTSTANDING UNIT AWARD, A U.S. ARMY COMMENDATION MEDAL, AND IN 

20 2012, SHE WAS THE RECIPIENT OF THE CAL-VET OUTSTANDING 

21 LEADERSHIP AWARD. ALTHOUGH ALL WHO WEAR THE UNIFORM HAVE MADE 

22 MANY SACRIFICES, INCLUDING EXTENDED TIME AWAY FROM THEIR 

23 FAMILIES, COLONEL JACKSON-KELLEY EXPRESSES THAT SHE IS DEEPLY 

24 GRATEFUL FOR THE TREASURED MOMENTS SHE PRESENTLY SHARES WITH 

25 HER FOUR GRANDCHILDREN. AGAIN, WE WISH TO THANK YOU AND ALL 
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1 VETERANS FOR YOUR CONTRIBUTIONS AND DEDICATED SERVICE TO OUR 

2 NATION. A BIG ROUND OF APPLAUSE, LADIES AND GENTLEMEN, FOR 

3 LIEUTENANT COLONEL JACKSON-KELLEY. [APPLAUSE.] 

4

5 COL. PATRICIA JACKSON-KELLEY: GOOD MORNING. ON BEHALF OF THE 

6 APPROXIMATELY 760,000 VETERANS RESIDING IN LOS ANGELES COUNTY, 

7 I HUMBLY ACCEPT THIS RECOGNITION GIVEN TODAY. THE ACCEPTANCE 

8 IS ALSO EXTENDED TO THE MORE THAN A DAY NUMBERS OF ACTIVE DUTY 

9 MILITARY, NATIONAL GUARD AND FORCES WHO HAVE COMMITTED SUICIDE 

10 OVER THE LAST YEAR. SIMPLY PUT, WE'RE LOSING MORE SERVICE 

11 MEMBERS BY THEIR OWN HANDS THAN BY THE ENEMY IN AFGHANISTAN. 

12 WE ALSO RECOGNIZE THAT LOS ANGELES HAS MORE THAN 6,000 

13 HOMELESS VETERANS. THERE'S A DEBT OF GRATITUDE EXTENDED TO THE 

14 BOARD OF SUPERVISORS WHO HAS EXTENDED INITIATIVES TO ERADICATE 

15 HOMELESSNESS AMONGST THE VETERANS. VETERANS DAY IS A TIME TO 

16 HONOR NOT JUST FOR THOSE WHO FOUGHT IN BATTLE BUT, IN FACT, 

17 ALL OF THE OUTSTANDING MEN AND WOMEN WHO SERVED OUR NATION IN 

18 THE ARMED FORCES SINCE OUR FOUNDING MORE THAN 237 YEARS AGO. 

19 IN CONCLUSION, LET US ALWAYS TREAT THE 22 MILLION VETERANS OF 

20 THE SAVIORS OF OUR COUNTRY THAT THERE ARE, EVEN WHEN THE GUNS 

21 ARE NO LONGER SHOOTING. THANK YOU FOR THIS HONOR. GOD BLESS 

22 AMERICA, AND GOD BLESS THE VETERANS. [APPLAUSE.]  

23

24 SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR YAROSLAVSKY. 

25
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1 SUP. YAROSLAVSKY: IS KEN BENSON HERE? COME ON UP, KEN. MEMBERS 

2 OF THE BOARD, LADIES AND GENTLEMEN, ALPHA-1, ANTITRYPSIN 

3 DEFICIENCY, KNOWN AS A.A.T. DEFICIENCY, OR ALPHA-1, IS ONE OF 

4 THE MOST COMMON, SERIOUS HEREDITARY DISORDERS IN THE WORLD AND 

5 CAN RESULT IN THE LIFE-THREATENING LIVER DISEASE IN CHILDREN 

6 AND ADULTS OR IN LUNG DISEASE IN ADULTS. ALPHA-1 HAS BEEN 

7 IDENTIFIED IN VIRTUALLY ALL POPULATIONS, AND IT IS ESTIMATED 

8 THAT 100,000 AMERICANS HAVE THIS DEFICIENCY, WHILE AS MANY AS 

9 25 MILLION MORE AMERICANS CARRY A SINGLE DEFICIENT GENE THAT 

10 CAUSES ALPHA-1 AND WHICH MAY PASS ON TO THEIR CHILDREN. ALPHA-

11 1 IS WIDELY UNDERDIAGNOSED AND MISDIAGNOSED WITH FEWER THAN 10 

12 PERCENT OF THOSE PREDICTED TO HAVE THE ALPHA-1-- TO HAVE 

13 ALPHA-1 CONFIRMED WITH THAT CONDITION. AND IT CAN TAKE AN 

14 AVERAGE OF FIVE DOCTORS OVER THE COURSE OF SEVEN YEARS FROM 

15 THE FIRST APPEARANCE OF SYMPTOMS TO MAKE A PROPER DIAGNOSIS, 

16 WHICH MERELY REQUIRES A SIMPLE BLOOD TEST. BECAUSE IT IS 

17 VITALLY IMPORTANT TO INCREASE PUBLIC AWARENESS AND ENCOURAGE 

18 EARLY DETECTION OF THIS SERIOUS HEREDITARY AND MISDIAGNOSED 

19 DISORDER, A NATIONWIDE EDUCATION CAMPAIGN HAS BEEN LAUNCHED 

20 FOR THE MONTH OF NOVEMBER TO BETTER INFORM THE PUBLIC AND THE 

21 MEDICAL COMMUNITY ABOUT ALPHA-1 AND THE OPTIONS FOR DETECTION 

22 AND TREATMENT FOR THOSE AFFECTED BY THE CONDITION. THE BOARD 

23 OF SUPERVISORS OF LOS ANGELES COUNTY WANTED TO PROCLAIM 

24 NOVEMBER 2013 AS ALPHA-1 AWARENESS MONTH THROUGHOUT LOS 

25 ANGELES COUNTY AND ENCOURAGES ALL RESIDENTS TO INFORM 
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1 THEMSELVES ABOUT THIS GENETIC CONDITION AND SUPPORT POLICIES 

2 AND PROGRAMS DESIGNED TO HELP THOSE BORN WITH OR CARRYING THE 

3 GENE. I'M JOINED BY KEN BENSON, WHO'S THE IMMEDIATE PAST CHAIR 

4 OF THE NATIONWIDE ALPHA-1 ASSOCIATION. HE'S A RESIDENT OF OUR 

5 DISTRICT. HAILS FROM WEST HILLS, AND HAS BEEN AFFECTED HIMSELF 

6 BY THIS DISORDER. AND SO HE'S REPRESENTING THE COMMUNITY OF 

7 PATIENTS AND ALL THOSE OUT THERE WHO WOULD BE HELPED BY SOME 

8 PROGRESS TOWARDS EARLY DETECTION. SO, KEN, THANK YOU FOR 

9 BRINGING THIS TO OUR ATTENTION. WE WANT TO PRESENT THIS 

10 PROCLAMATION TO YOU, ASK YOU TO SAY A FEW WORDS, IF YOU WILL. 

11

12 KEN BENSON: THANK YOU SO MUCH, SUPERVISOR. LADIES AND 

13 GENTLEMEN. I AM A PATIENT. IT TOOK ME NINE YEARS TO GET 

14 DIAGNOSED. AND BY THE TIME I WAS, MY LUNG CONDITION HAD FAILED 

15 TO THE POINT WHERE I WAS DISABLED. IT CONTINUES TO FAIL, BUT 

16 NOWHERE NEAR THE RATE IT HAS. IT'S VERY PERSONAL. I HAVE 

17 FRIENDS OF MINE WHO HAVE HAD LUNG TRANSPLANTS IN THEIR 40S, 

18 FRIENDS WHO HAVE DIED BECAUSE THEY COULDN'T GET THEM. I KNOW 

19 FAMILIES WHO HAVE HAD TWO-YEAR-OLD INFANTS GET LIVER 

20 TRANSPLANTS BECAUSE OF THIS. THEY CALL IT A RARE DISEASE. WE, 

21 THE PATIENTS, CALL THIS A RARELY DIAGNOSED DISEASE. AND WITH 

22 YOUR HELP, WE'RE GOING TO BRING AWARENESS TO THE MEDICAL 

23 COMMUNITY AND THE POPULATION IN GENERAL SO WE DON'T HAVE SO 

24 MANY PEOPLE SUFFERING AND HAVE GOVERNMENT PAYING SO MUCH MONEY 
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1 TO TAKE CARE OF THEIR CARE WHEN IT'S NEEDLESS WITH EARLY 

2 DETECTION. THANK YOU VERY MUCH. [APPLAUSE.] 

3

4 SUP. RIDLEY-THOMAS, CHAIRMAN: SUPERVISOR ANTONOVICH, PLEASE. 

5

6 SUP. ANTONOVICH: MR. CHAIR AND MEMBERS, IT'S A PLEASURE TO 

7 WELCOME BACK TO LOS ANGELES COUNTY AMBASSADOR BRUCE LINGHU, 

8 WHO HAD BEEN POSTED HERE MANY, MANY YEARS BEFORE AND DONE A 

9 GREAT JOB, AND NOW HE IS THE NEW CONSUL GENERAL, DIRECTOR 

10 GENERAL OF THE TAIPEI ECONOMIC CULTURAL OFFICE IN LOS ANGELES 

11 COUNTY. HE LEADS A VERY BUSY OFFICE BECAUSE THEY'RE INVOLVED 

12 WITH TRADE, EDUCATIONAL AND CULTURAL EXCHANGES AND 

13 RELATIONSHIPS BETWEEN NOT JUST LOS ANGELES COUNTY BUT 

14 THROUGHOUT THE OTHER AREAS THAT HE HAS JURISDICTION OVER, 

15 INCLUDING ARIZONA AND NEW MEXICO. TAIPEI IS CALIFORNIA'S 

16 LEADING TRADE PARTNER WITH EXPORTS INCLUDING ELECTRONICS AND 

17 COMPUTERS, INDUSTRIAL MACHINERY, TRANSPORTATION EQUIPMENT AND 

18 AGRICULTURAL PRODUCTS. THEY ALSO PROMOTE THE BILATERAL TRADE, 

19 INVESTMENT AND TECHNOLOGICAL EXCHANGE AND COOPERATION. THE 

20 AMBASSADOR'S WELL ACQUAINTED WITH LOS ANGELES COUNTY BECAUSE 

21 HE HAD BEEN HERE BETWEEN 1987 TO 1993 AND FROM '97 TO 2001. 

22 AND WE'RE VERY PLEASED TO WELCOME THE AMBASSADOR BACK AND WE 

23 KNOW HE'LL DO A GOOD JOB AS HE'S DONE IN THE PAST AND AS HE'S 

24 DONE FOR HIS COUNTRY. BRUCE? [APPLAUSE.] 

25
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1 HON. BRUCE LINGHU: THANK YOU, HONORABLE SUPERVISOR ANTONOVICH 

2 AND THE OTHER HONORABLE MEMBERS OF THE BOARD OF COUNTY 

3 SUPERVISORS. YOU KNOW, GOOD MORNING. IT'S SUCH A GREAT HONOR 

4 AND PLEASURE FOR ME TO BE HERE THIS MORNING AND TO RECEIVE 

5 THIS WARM WELCOME CERTIFICATE. AS SUPERVISOR ANTONOVICH HAS 

6 MENTIONED, THAT THIS NEW ASSIGNMENT TO THE DIRECTOR GENERAL OF 

7 TAIPEI ECONOMIC CULTURAL OFFICE IN LOS ANGELES MARKS THE 

8 SECOND RETURN TO LOS ANGELES FOR MYSELF. AND THIS MEANS A 

9 GREATER JOB AND GREATER RESPONSIBILITY. AS I QUOTE FROM FORMER 

10 SECRETARY OF STATE HILLARY CLINTON, THAT TAIWAN IS AN 

11 IMPORTANT SECURITY AND ECONOMIC PARTNER TO THE UNITED STATES. 

12 INDEED, WE HAVE A VERY STRONG PARTNERSHIP IN TERMS OF 

13 SECURITY, COOPERATION. YOU KNOW, TOGETHER WE ARE THE IMPORTANT 

14 FORCE FOR STABILIZING THE WESTERN-PACIFIC REGION. BUT ALSO WE 

15 ARE VERY IMPORTANT AND STRONG ECONOMIC AND CULTURAL PARTNERS, 

16 AS WELL. THAT TAIWAN IS NO. 11 LARGEST TRADING PARTNER TO THE 

17 UNITED STATES, WHILE U.S. IS NO. 3 TO TAIWAN. AND TO 

18 CALIFORNIA, WE ARE NO. 7 LARGEST TRADING PARTNER TO EACH 

19 OTHER. AND TO SOUTHERN CALIFORNIA, OR LOS ANGELES AREA, TAIWAN 

20 IS NO. 4 IMPORTANT TRADING PARTNER TO THIS REGION. ALSO IN 

21 TERMS OF CULTURAL RELATIONS THAT WE HAVE 25,000 STUDENTS 

22 STUDYING IN THE UNITED STATES. AND WE ARE THE NO. 5 LARGEST 

23 STUDENT BODY, FOREIGN STUDENT BODY IN THE UNITED STATES. AND 

24 ALSO IN GREATER LOS ANGELES AREA, THE SISTER CITY RELATIONSHIP 

25 BETWEEN THE COUNTY OF LOS ANGELES AND THE NEW TAIPEI CITY, BUT 
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1 ALSO THE CITY OF L.A. IS THE SISTER CITY WITH TAIPEI, WHILE 

2 CALIFORNIA AND TAIWAN ARE SISTER STATES. AND LOS ANGELES AREA 

3 I THINK IS THE BIGGEST TAIWANESE AND CHINESE COMMUNITIES IN 

4 THE UNITED STATES. SO MY OFFICE IS SERVING THE COMMUNITY AND 

5 ALSO PROMOTING THE BILATERAL RELATIONS OVERALL. WE HAVE A VERY 

6 BIG OPERATION HERE, PROBABLY ONE OF THE BIGGEST CONSULAR 

7 OFFICES IN LOS ANGELES. I HAVE CONSULAR SERVICE WHERE I HAVE 

8 ECONOMIC DIVISION, CULTURAL DIVISION, EDUCATION DIVISION, 

9 SCIENCE AND TECHNOLOGY DIVISION AND TOURISM DIVISION, 

10 INFORMATION DIVISION THAT TOGETHER I THINK WE CAN PROMOTE THE 

11 ALREADY VERY STRONG RELATIONSHIP AND PARTNERSHIP. SO WITH YOUR 

12 HELP, I THINK A LOT OF GOOD FRIENDS HERE, THE BEST THING TO 

13 COME BACK IS TO RENEW MY FRIENDSHIP WITH A LOT OF OLD FRIENDS 

14 AS THE NEW DELEGATION, BUT I'M AN OLD FRIEND HERE. SO EVERY 

15 DAY I CAN ALSO MEET A LOT OF NEW FRIENDS. I THINK THAT'S THE 

16 BEST THING OF THIS JOB FOR ME. SO I HOPE THAT WE CAN FURTHER 

17 ENHANCE THE RELATIONS BETWEEN OUR TWO COUNTRIES AND TO THE 

18 REGION AND TO TAIWAN AS WELL AS MAYBE HELPING US TO ESTABLISH 

19 FREE TRADE AGREEMENT RELATIONS OR BILATERAL INVESTMENT 

20 AGREEMENTS WITH UNITED STATES AND ALSO SUPPORTING OUR 

21 MEMBERSHIP AT THE CHINESE PACIFIC PARTNERSHIP. I THINK THIS IS 

22 MUTUALLY BENEFICIAL TO FURTHER PROMOTE OUR BILATERAL TRADES 

23 AND CULTURAL TIES. SO THIS MORNING, THANK YOU SO MUCH TO GIVE 

24 ME THIS OPPORTUNITY TO BE HERE, AND MY BEST WISHES TO ALL OF 

25 YOU. THANK YOU VERY MUCH. [APPLAUSE.] 
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1

2 SUP. ANTONOVICH: THE MONTH OF NOVEMBER IS ADOPTION AWARENESS 

3 MONTH IN THE COUNTY OF LOS ANGELES. AND OUR DEPARTMENT OF 

4 CHILDREN AND FAMILY SERVICES, WHICH IS THE LARGEST CHILD 

5 WELFARE AGENCY IN THE COUNTRY, SO WE HAVE THOUSANDS OF 

6 CHILDREN THAT ARE IN NEED OF ADOPTIVE FAMILIES, MENTORS, AND 

7 IT'S IMPORTANT THAT WE BRING THIS AWARENESS TO RECRUIT FROM 

8 OUR CHURCHES, OUR SYNAGOGUES AND OUR COMMUNITY WHO WOULD LIKE 

9 TO BECOME FOSTER PARENTS, WHO WOULD LIKE TO BECOME MENTORS. 

10 THE MISSION OF THE DEPARTMENT IS TO FIND PERMANENCY IN 

11 RECRUITING, PREPARING AND SUPPORTING FAMILIES TO PROVIDE THIS 

12 HEALTHY, STABLE, LOVING AND PERMANENT HOME TO THESE CHILDREN 

13 WHO COULD NOT HAVE SAFETY LIVES FROM THEIR PARENTS. WE WOULD 

14 LIKE TO ENCOURAGE FAMILIES AND OTHERS IN THE COMMUNITY. YOU 

15 CAN CALL THE HOTLINE 888-811-1121. AND TODAY WE'RE GOING TO 

16 HONOR TWO OUTSTANDING FAMILIES, TWO OUTSTANDING ROLE MODELS OF 

17 FAMILIES WHO HAVE COME TOGETHER TO PROVIDE CHILDREN A HOME 

18 WITH LOVE, SUPPORT AND A FOUNDATION. SHERIDAN AND JEFFREY 

19 JACKSON ARE THE PROUD ADOPTIVE PARENTS OF SEVEN CHILDREN WITH 

20 SPECIAL NEEDS. BY ADOPTING THESE SEVEN SIBLINGS, THEY ALLOWED 

21 THESE CHILDREN TO GROW UP TOGETHER INSTEAD OF BEING ADOPTED BY 

22 SEPARATE FAMILIES. THIS FAMILY STEPPED FORWARD TO ADOPT SEVEN 

23 SPECIAL NEEDS CHILDREN. SARAH, VALENCIA, DEANDRE RANDOLPH, 

24 STEFSON, MICA AND ADORA. AND THEY ARE GOING TO ENSURE THAT 

25 THESE CHILDREN WILL HAVE THE EDUCATIONAL NEEDS TO BE MET AND 
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1 THAT EACH CHILD WILL HAVE THE OPPORTUNITY TO REACH THEIR FULL 

2 POTENTIAL. THE NEXT FAMILY WE'RE HONORING IS INA REDAU AND 

3 JOSEPH CARNAGE. THEY ARE PROUD ADOPTIVE PARENTS OF LEVI AND 

4 DANIEL, BOTH OF WHOM HAVE SIGNIFICANT MEDICAL NEEDS AND 

5 REQUIRE AROUND-THE-CLOCK MEDICAL CARE. INA AND JOSEPH HAVE 

6 DEDICATED THEIR LIVES TO PROVIDING LEVI AND DANIEL WITH A 

7 SAFE, LOVING AND NURTURING HOME TO GROW IN. AND PRIOR TO 

8 ADOPTING, THEY ASSISTED THE DEPARTMENT OF CHILDREN AND FAMILY 

9 SERVICES BY OFFERING SOME OF THE MOST DIFFICULT CHILDREN TO BE 

10 PLACED IN A LOVING HOME INSTEAD OF ASSISTED LIVING FACILITY. 

11 AND SO THESE TWO FAMILIES WE REALLY RECOGNIZE THEM. AND I KNOW 

12 THAT THE CHILDREN ARE GOING TO APPRECIATE THE LOVE AND SUPPORT 

13 THAT THEY HAVE GIVEN AND WILL BE PROVIDING THESE CHILDREN. WE 

14 ENCOURAGE OTHERS WHO ARE LISTENING TO ALSO STEP FORWARD SO 

15 THAT THESE CHILDREN THAT WE DO HAVE IN THE COUNTY WILL BE ABLE 

16 TO HAVE THE SAME TYPE OF LOVE AND FAMILY NURTURING AS THESE 

17 TWO WONDERFUL FAMILIES ARE PROVIDING THESE CHILDREN. SO AT 

18 THIS TIME, WE'RE GOING TO GIVE PROCLAMATIONS TO THE TWO 

19 FAMILIES. AND THEY CAN EACH SAY SOMETHING. AND MR. PHIL 

20 BROWNING CAN ALSO SAY A FEW WORDS, AS WELL. [APPLAUSE.] 

21

22 INA REDAU: HI, MY NAME IS INA, AND I THANK YOU VERY MUCH FOR 

23 RECOGNIZING US FOR ALL THIS GOOD WORK. THROUGH FOR MY LOVELY 

24 SON DANIEL. IT'S A PLEASURE HAVING HIM AND I'M LOOKING FORWARD 

25 TO MY OTHER ADOPTED SON. IT'S A LOT OF WORK. I FEEL LIKE A 
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1 NURSE EVERY DAY, AND I'M HERE TO BLESS HIM WITH A WONDERFUL 

2 HOME AND A WONDERFUL FAMILY. AND HE'S A BLESSING TO US. AND 

3 THE DAY I MET DANIEL, THEY TOLD ME HE WAS DYING. I SAID "NO, 

4 HE'S NOT DYING." AND I SAID, "I'M GOING TO TAKE ON THE 

5 CHALLENGE. THERE'S NOTHING WRONG WITH HIM. HE JUST NEEDS 

6 LOVE." AND THIS IS DANIEL. AND HE'S STILL ALIVE. HE'S NOT 

7 DEAD. [APPLAUSE.] AND THANK YOU ALL VERY MUCH. 

8

9 SPEAKER: I REALLY AND TRULY DO APPRECIATE AND LOVE ALL MY 

10 CHILDREN, MY WIFE. IT'S JUST BEEN A BEAUTIFUL-- IT'S BEEN A 

11 BLESSING TO US, ACTUALLY. WE JUST WERE GOING TO HAVE A COUPLE 

12 OF KIDS TO GO WITH MY SON HERE, BUT IT TURNED OUT THAT WE END 

13 UP WITH A LOVELY FAMILY, LOVELY. I APPRECIATE IT. THANK YOU, 

14 GUYS. 

15

16 SPEAKER: I JUST WANT TO GIVE A SPECIAL THANKS TO BECKY 

17 MERIWETHER WHO BELIEVED IN US TO BE ABLE TO TAKE CARE OF ALL 

18 OF THESE CHILDREN, BECAUSE WITHOUT HER, THIS WOULDN'T HAVE 

19 BEEN POSSIBLE AT ALL. SHE SAW THE POTENTIAL, THE LOVE AND THE 

20 NURTURING FAMILY. AND CANDICE MORET, WHO SUPPORTED US EVERY 

21 STEP OF THE WAY. AND I JUST WANT TO THANK THE DEPARTMENT OF 

22 CHILDREN AND FAMILY SERVICES FOR SUPPORTING US IN OUR DREAM. 

23 THANK YOU. 

24
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1 PHILIP BROWNING: I'D JUST LIKE TO SAY THANK YOU ON BEHALF OF 

2 ALL THE DEPARTMENT'S SOCIAL WORKERS. IT'S AMAZING TO HAVE A 

3 SIBLING SET OF SEVEN KIDS ADOPTED, IT REALLY IS. AND I KNOW 

4 YOU COULDN'T DO IT WITHOUT THE GRANDMOTHER OVER HERE, MISS 

5 RUFFIN WHO I MET EARLIER. GRANDMOTHERS ARE SO CRITICAL TO ALL 

6 OF US. AND SO I DO WANT TO HOLD HER UP AND I DO REALLY THINK 

7 IT'S AMAZING THAT WE'VE BEEN ABLE TO WORK TOGETHER IN SUCH A 

8 COLLABORATIVE MANNER TO MAKE SUCH A DIFFERENCE IN THE LIVES OF 

9 THESE CHILDREN. SO I WOULD JUST CLOSE BY SAYING THANK YOU SO 

10 VERY MUCH. [APPLAUSE.] 

11

12 SUP. ANTONOVICH: TODAY WE HAVE MARSHA MIETA, WHO IS THE 

13 DIRECTOR OF THE DEPARTMENT OF ANIMAL CARE AND CONTROL, IN 

14 RECOGNITION OF NATIONAL ANIMAL SHELTER APPRECIATION WEEK. THIS 

15 WAS INSTITUTED BACK IN 1996 BY THE HUMANE SOCIETY OF THE 

16 UNITED STATES. THEY RECOGNIZED THE ROLE SHELTERS PLAY IN 

17 COMMUNITIES AND INCREASE THE PUBLIC AWARENESS OF ANIMAL 

18 WELFARE ISSUES. THE DEPARTMENT IS RESPONSIBLE FOR THE WELL-

19 BEING AND WELFARE OF OVER 80,000 ANIMALS EACH YEAR. LAST YEAR 

20 THEY PLACED 31,000 PETS INTO NEW HOMES AND REUNITED 6,000 

21 ANIMALS WITH THEIR OWNERS. THE DEPARTMENT CURRENTLY OPERATES 

22 SIX ANIMAL SHELTERS IN OUR COUNTY, AND THE BOARD ENCOURAGES 

23 THE RESIDENTS TO VISIT THESE SHELTERS AND BECOME ADOPTIVE-- 

24 CONSIDER ADOPTING A DOG OR CAT. OR YOU CAN CALL THE TELEPHONE 
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1 NUMBER, 562-728-4610. SO FIRST, MARSHA WILL SAY A COUPLE WORDS 

2 AND THEN WE WILL INTRODUCE OUR SPECIAL GUESTS. 

3

4 MARSHA MEYEDA: THANK YOU, SUPERVISOR. I'D LIKE TO THANK THE 

5 BOARD OF SUPERVISORS FOR RECOGNIZING OUR DEPARTMENT TODAY AND 

6 ALSO ALL OF THE EMPLOYEES AND VOLUNTEERS AT THE DEPARTMENT OF 

7 ANIMAL CARE AND CONTROL THAT WORK EVERY DAY TO FIND LIVE 

8 OUTCOMES AND NEW HOMES FOR ALL THE ANIMALS THAT COME INTO OUR 

9 SHELTER AS WELL AS PROTECT THE PUBLIC FROM DANGEROUS ANIMALS 

10 OUT IN THE COMMUNITIES THANK YOU VERY MUCH. 

11

12 SUP. ANTONOVICH: OKAY. THIS IS JEWELS, WHO SHE'S A LITTLE 

13 GERMAN SHEP. AND SHE'S 12 WEEKS OLD. SHE HAS A CUTE LITTLE 

14 WHITE STREAK FROM THE TOP OF HER FOREHEAD TO THE BOTTOM OF HER 

15 LITTLE NOSE. SO THIS IS LITTLE JEWEL, A BUNDLE OF JOY, AND 

16 SHE'S LOOKING FOR A LITTLE HOME. NO MORE SPEAKERS? OKAY. LET'S 

17 DO THE PICTURE. 

18

19 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, SUPERVISOR 

20 ANTONOVICH. THAT CONCLUDES THE PRESENTATIONS FOR THIS MORNING 

21 AND JEWEL BIDS US FAREWELL AS-- HE OR SHE-- SHE RETURNS WITH 

22 THE CARE OF THE DEPARTMENT OF ANIMAL SERVICES. MADAME 

23 EXECUTIVE OFFICER. 

24
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1 SACHI HAMAI, EXEC. OFFICER: MR. CHAIRMAN, AT THIS TIME THERE 

2 IS A NUMBER OF INDIVIDUALS WHO HAVE EITHER ONE OR MULTIPLE 

3 ITEMS THAT THEY'VE HELD? 

4

5 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. WE'LL BEGIN WITH THE 

6 FOLLOWING PERSONS. SELENA ROJHANI. LORI MARTIN. GENEVIEVE 

7 CLAVREUL. ERIC PREVEN. IF THE FOUR OF YOU WOULD COME FORWARD? 

8

9 SELENA ROJHANI: GOOD MORNING, I'M SELENA ROJHANI, APPEARING ON 

10 ITEM NO. 31. 

11

12 SUP. RIDLEY-THOMAS, CHAIRMAN: PLEASE TAKE A SEAT, MA'AM. YOU 

13 MAY BE SEATED. INDEED. BACK TO 3, PLEASE. MS. ROJHANI, THE 

14 FLOOR IS YOURS. 

15

16 SELENA ROJHANI: MY OFFICE REPRESENTS ONE OR MORE OF THE 

17 BIDDERS ON THIS SOLICITATION. PROPOSALS FOR THIS SOLICITATION 

18 WERE SUBMITTED TO THE COUNTY ALMOST TWO YEARS AGO. MY CLIENTS 

19 BELIEVE STRONGLY THAT THIS EXTENDED PERIOD OF TIME BETWEEN THE 

20 SOLICITATION AND AWARD HAS RENDERED LANGAN'S PROPOSAL OUTDATED 

21 AND UNRELIABLE IN A NUMBER OF WAYS. FIRST AND FOREMOST, LANGAN 

22 WAS AWARDED THE SOLICITATION BECAUSE OF ITS HIGHLY QUALIFIED 

23 PERSONNEL. HOWEVER, OUT OF THE FIVE KEY PERSONNEL, THREE HAVE 

24 BEEN DISPLACED. ONE, MICHAEL CHENDORIAN NO LONGER WORKS AT 

25 LANGAN AT ALL. SECOND, RUDOLPH PRIZZI NOW LIVES IN NEW JERSEY. 
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1 AND THIRD, DERENADA SHIPMAN IS NOW IN SAN FRANCISCO. THESE 

2 PERSONNEL CHANGES COMPLETELY CHANGE THE PROPOSED KEY TEAM. AND 

3 THESE ARE THE ONLY CHANGES WE WERE INFORMED OF DIRECTLY FROM 

4 CORPORATE OFFICES. THERE MAY BE OTHERS THAT ARE EXPOSING THE 

5 COUNTY TO LIABILITIES AND DIFFICULTIES THAT WE'RE NOT AWARE 

6 OF. MOREOVER, THE COUNTY'S REQUIRED CERTIFICATIONS ARE NOW ALL 

7 NEARLY TWO YEARS OLD. TO NAME A FEW, C.B.E. PROGRAM, AVOIDANCE 

8 OF CONFLICT OF INTEREST, E.E.O. CERTIFICATION, LOBBYIST 

9 ORDINANCE, THREE-YEAR CONTRACTING HISTORY, CIVIL LITIGATION 

10 HISTORY, CRIMINAL CONVICTIONS, JURY SERVICE, LABOR PAYROLL 

11 VIOLATIONS, PROPERTY TAX REDUCTION PROGRAM AND DEBARMENT ARE 

12 ALL OUTDATED. AS I MENTIONED BEFORE, WE DON'T KNOW WHAT MAY 

13 HAVE CHANGED FOR LANGAN IN THE PAST TWO YEARS THAT MAY HAVE 

14 NEGATIVELY AFFECTED THESE CERTIFICATIONS. THE COUNTY MAY BE 

15 EXPOSING ITSELF TO LIABILITY WITH THESE OUTDATED 

16 CERTIFICATIONS, AND WE'RE BRINGING THIS TO THE ATTENTION OF 

17 THE BOARD. WE REQUEST THE BOARD TO VOTE AGAINST APPROVING THIS 

18 CONTRACT AND ASK THE COUNTY TO REISSUE THIS SOLICITATION SO 

19 THAT A SELECTION COULD BE MADE WITH UPDATED AND RELIABLE 

20 PROPOSALS AND CERTIFICATIONS. THANK YOU. 

21

22 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. 

23 WE'LL TAKE THE NEXT SPEAKER, PLEASE. 

24
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1 LORI MARTIN: GOOD MORNING. I SIGNED BY UP FOR SEVERAL ITEMS 

2 BUT MY MAIN CONCERN IS ITEM 17 DUE TO THE FACT THAT MR. 

3 BROWNING'S ITEM 18 IS $10,000 DONATED. WHY CAN'T WE LESSEN THE 

4 AMOUNT TO $89,000 RATHER THAN $99,000 FOR A PREDICTION SERVICE 

5 TO PREDICT ABUSE OF CHILDREN RATHER THAN ACTUALLY PROVE IT? 

6 THIS IS GOING TO BE EVEN MORE TRAVESTY FOR THE PUBLIC AND 

7 THEIR CHILDREN AND THEIR RIGHTS OF THEIR FAMILY UNIT. AS FOR 

8 ITEM NO. 9, THAT SHOULD BE SEEN COMPLETELY ILLEGAL. MR. 

9 ANTONOVICH, I'M QUITE DISAPPOINTED THAT YOU'RE SUPPORTING ITEM 

10 NO. 9. AS A MATTER OF FACT, TO PUT PICTURES AND VIDEO OF 

11 FOSTER CHILDREN UP AND ADVERTISE THEM LIKE PRODUCTS IS A 

12 VIOLATION OF THEIR CIVIL RIGHTS. WHEN I WAS A WARD OF THE 

13 COURT, MY PHOTOGRAPH COULD NOT BE DISPLAYED IN MEDIA, PUBLIC 

14 OR ANYWHERE ELSE BECAUSE I WAS CONSIDERED TO BE IN PROTECTIVE 

15 CUSTODY. NOW, I'M QUITE DISGUSTED WITH THE WAY THINGS ARE 

16 GOING WITH THIS DEPARTMENT, AS ALWAYS. NOW THEY'RE EVEN 

17 ATTACKING CELEBRITIES TO MAKE A POINT THAT THEY DON'T JUST 

18 ATTACK CALWORKS RECIPIENTS, EVEN THOUGH 55 PERCENT OF THEIR 

19 OPEN CASES ARE CALWORKS RECIPIENTS. YOU KNOW, IT'S REALLY 

20 UNFORTUNATE THAT YOU GUYS CAN'T SEE THAT THEY'RE OPERATING 

21 ILLEGALLY EVEN DOWN TO EDELMAN. NOW, IT'S NO SURPRISE TO ME 

22 THAT EDELMAN HAS BEEN FINED. AND THE A.D.A. ACCESS BOARD WILL 

23 CONTINUE TO RECEIVE COMPLAINTS FROM DISABLED PARTIES WHO HAVE 

24 TO ATTEND THAT VENUE. THIS COUNTY KNEW WHEN OPENING IT FOR A 

25 PUBLIC USE VENUE THAT IT WAS NOT COMPLIANT TO THE A.D.A. 
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1 STANDARDS. WHY DID YOU ALLOW EDELMAN TO BE PLACED IN SUCH A 

2 PLACEMENT LIKE THAT? I SEE PEOPLE IN WHEELCHAIRS TRYING TO 

3 STRUGGLE TO GET UP THERE. I'VE SEEN PEOPLE ALMOST FALL DOWN 

4 THAT HILL. AND IT'S ALMOST AS IF YOU'RE MAKING IT IMPOSSIBLE 

5 FOR THE PARTICIPANTS TO MAKE IT TO THEIR HEARINGS BECAUSE IN 

6 ALL THE CLAUSES, WE CAN PROCEED WITHOUT YOU THERE. ALL THE 

7 COURT DOCUMENTATION HAS THAT ON THERE. IS THAT WHY EDELMAN'S 

8 LOCATED AT SUCH A HIGH GRADED HILL? AS I TOLD MR. MAREN, I 

9 WILL NOW MAKE IT A PERSONAL, PERSONAL VENDETTA TO GO TO ALL 

10 PUBLIC USE BUILDINGS AND SEE WHAT IT IS IN VIOLATION OF. I 

11 EXPRESS TO YOU I'M A LAND USE CONSULTANT BY TRADE. IT REALLY 

12 WASN'T WISE TO ATTACK A PARTY LIKE MYSELF. HAVE A GOOD DAY. 

13

14 SUP. RIDLEY-THOMAS, CHAIRMAN: NEXT SPEAKER, PLEASE. 

15

16 ERIC PREVEN: YES, IT'S ERIC PREVEN, THE COUNTY RESIDENT FROM 

17 DISTRICT 3. GOOD MORNING, BOARD OF SUPERVISORS. IT WAS NICE TO 

18 SEE THE GENTLEMAN FROM TAIPEI HERE, I KNOW SUPERVISOR 

19 ANTONOVICH WAS THERE QUASI RECENTLY. I CAN'T GET EXACTLY THE 

20 DATES, BUT THAT IS EXCITING TO SEE THAT WE ARE WORKING WELL 

21 THERE. ITEM 1-D, I HAVE TO CONFESS WE HAVE RUN INTO A LITTLE 

22 BIT OF GROUND ON THAT ONE REGARDING TWO COMPANIES THAT HAVE 

23 ENGAGED FOR TEMPORARY SERVICES FOR OUR COMMUNITY DEVELOPMENT 

24 COMMISSION. ONE OF THEM IS CALLED LLOYD'S STAFFING. AND THERE 

25 WERE SOME REPRESENTATIONS THAT THEY MADE ABOUT BEING WOMEN-
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1 OWNED AND MINORITY BUSINESS WHEN IN FACT ON THE DOCUMENT THAT 

2 THE BOARD SEES, THEY'RE DESCRIBED AS NON-MINORITY. YET THEY 

3 GOT A SPECTACULARLY HIGH POINT RATING AND WON THIS R.F.P. I 

4 ASKED THE COMMUNITY DEVELOPMENT COMMISSION, WHO IS VERY 

5 RESPONSIVE BUT HAS NOT YET RESPONDED, SO I WOULD ASK THAT THE 

6 BOARD WAIT FOR THEM TO RESPOND APPROPRIATELY BECAUSE WE DO 

7 WANT FAIR REPRESENTATIONS IN OUR PROCUREMENTS FOR THESE KINDS 

8 OF TEMPORARY OR ANY KIND OF WORK, FRANKLY. THE ITEM NO. 32, OF 

9 COURSE, IS A MEASURE OF PROGRESS. PUBLIC WORKS IS NOW 

10 DISCLOSING MORE CLEARLY HOW THESE JOB ORDER CONTRACTS WORTH 

11 $4.3 MILLION EACH, THERE ARE ABOUT 60 MILLION OF THEM THAT ARE 

12 BEING HANDED OUT, AND WHAT IT DOES IS IT ACTUALLY ALLOWS US TO 

13 SEE VERY CLEARLY THAT THERE'S A SERIES OF USUAL CUSTOMERS WHO 

14 ARE ABLE TO BID EXTREMELY LOW MULTIPLES FOR THESE CONTRACTS 

15 AND WHEN. ONE THAT CAUGHT MY ATTENTION, HARRY JOE, WHO IS A 

16 REGULAR COUNTY CONTRACTOR, RECEIVED-- PUT IN A BID AT, I KID 

17 YOU NOT, 49 CENTS ON THE DOLLAR. SO IF THAT DOES NOT RAISE ANY 

18 QUESTIONS FROM A BOARD OF SUPERVISORS, I DON'T KNOW WHAT 

19 WOULD. I MEAN, THAT IS-- HOW CAN THE MAN POSSIBLY DELIVER? AND 

20 THEN OTHER COMPANIES LIKE MCCONE AND M.T.M. AND, TO BE 

21 SPECIFIC ACE, ARE BANKING SEVERAL OF THESE AGREEMENTS AT ONCE 

22 AT EXTREMELY COMPETITIVE MULTIPLES. SO FROM A BOARD OF 

23 SUPERVISORS' POINT OF VIEW, THE QUESTION OF HOW WOULD THIS 

24 AFFECT SMALLER COMPANIES' OR CONTRACTORS' ABILITY TO COMPETE? 

25 AND THE ANSWER IS THEY CAN'T POSSIBLY COMPETE. AND IT RAISES 
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1 LOTS OF QUESTIONS ABOUT HOW THAT PROCESS IS WORKING. THIS IS 

2 THE GORDIAN GROUP. THEY MAKE A FORTUNE OFF OF L.A. COUNTY 

3 BUSINESS AND OTHERS. I WOULD ASK YOU TO DIG DEEPER, FOLKS. DIG 

4 DEEPER. IT'S NOT IN THE PUBLIC INTEREST TO BE HELD OFF TO THE 

5 SIDE ON THAT. ITEM 17 WE'VE HAD A LITTLE PROBLEM WITH THE 

6 REPORTING. WE HAVE A NEW LOBBYIST REPORTING FORMS, APPARENTLY. 

7 BUT NOW IT'S ONLINE BUT YOU STILL CAN'T ACCESS IT. THE 

8 EXECUTIVE OFFICE, ON NOVEMBER 5TH IS NOT ABLE TO CONNECT ME TO 

9 WHAT ARNIE BERGHOFF TOOK FROM S.A.S. INSTITUTE INC., WHICH IS 

10 A COMPANY THAT'S GIVING-- THEY'RE TAKING 99,000 TO DO THE DATA 

11 MINING THAT MY COLLEAGUE SUGGESTED A MOMENT AGO. IT'S 

12 APPROPRIATE TO KNOW HOW MUCH INFLUENCE IS GOING ON, GUYS. WE 

13 WANT TO LOOSEN UP, NOT TIGHTEN UP THE ACCESS TO THIS MATERIAL. 

14 AND ITEM 40 IS THE SHERIFF HAS BROUGHT IN A GUY WHO HIS NAME 

15 IS JAMES COPELAND, I BELIEVE IT'S COPELAND, AND THIS GUY IS-- 

16

17 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. MR. PREVEN, YOUR TIME 

18 HAS EXPIRED. DR. CLAVREUL. THANK YOU. 

19

20 DR. GENEVIEVE CLAVREUL: GOOD MORNING, BOARD OF SUPERVISORS. 

21 DR. GENEVIEVE CLAVREUL. ON ITEM 19, HAVING TO DO WITH THE 

22 PATIENT SAFETY NET SYSTEM, I JUST WONDER IF ANY RESEARCH HAS 

23 BEEN DONE TO SEE OUR EFFECTIVE THAT SYSTEM WAS. I TRIED TO 

24 FIND SOME INFORMATION, YET I WAS NOT ABLE TO ACCESS ANY OF 

25 THEM. AND IF IT'S WORKING WELL, THEN DEFINITELY WE SHOULD KEEP 
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1 ON DOING IT. BUT IT WOULD BE NICE IF WE COULD CHECK HOW 

2 EFFECTIVE THEY ARE. ON ITEM 20, HAVING TO DO WITH INTENSIVIST 

3 OR HOSPITALIST FOR BOTH HARBOR-U.C.L.A. AND RANCHO, YOU KNOW, 

4 THOSE ARE TWO ROLES WHO ARE VERY IMPORTANT BUT MOST OF THE 

5 TIME HOSPITAL UTILIZES PEOPLE WHILE FAMILY PRACTICE TO DO THAT 

6 AND ACTUALLY ON THE REQUIREMENT HERE, YOU WERE ASKING FOR 

7 SPECIALISTS IN DIFFERENT AREAS AND USUALLY THOSE ARE NOT 

8 SPECIALTY WHICH ARE IDENTIFIED FOR INTENSIVIST AND 

9 HOSPITALIST. ON ST. FRANCIS, ITEM 21, WE HAVE BEEN COVERING 

10 FOR TRAUMA AT ST. FRANCIS FOR QUITE SOMETIME SINCE THE DEBACLE 

11 AT M.L.K. PERSONALLY I WONDER IF THE N.S.A. AGENT WHO GOT SHOT 

12 LAST WEEK WOULD HAVE SURVIVED IF THE TRAUMA AT M.L.K. HAD BEEN 

13 OPEN. AND WE HAVE SEEN THAT MONEY GOING TO ST. FRANCIS PRETTY 

14 CONSISTENTLY. AND ACTUALLY MORE PATIENTS GO TO HARBOR-U.C.L.A. 

15 VERSUS ST. FRANCIS, WONDER WHY. ON ITEM 22, I'M TOTALLY IN 

16 FAVOR OF PURCHASING AUTOMATED ROBOTIC SYSTEM FOR M.L.K. BUT 

17 IT'S A LITTLE BIT EARLY. BECAUSE AS FAR AS I KNOW, THAT 

18 HOSPITAL IS NOT FINISHED AND OPEN ANY TIME SOON. SO I THINK 

19 IT'S A LITTLE PREMATURE TO PUT THAT MUCH MONEY ASIDE FOR THAT 

20 EVEN THOUGH IT SHOULD BE DONE. I'M STILL IN NEED OF GETTING 

21 DOCUMENTATION ON M.L.K. CORPORATION, ABOUT THEIR RENT, THEIR 

22 LEASE, WHERE THE MONEY HAS GONE. EVENTUALLY I'M SURE YOU WILL 

23 DO IT BECAUSE YOU HAVE TO. SO IT WOULD BE EXTREMELY NICE. AND 

24 I WOULD ALSO LIKE TO KNOW IF ZEV HAVE RECEIVED REPLIES TO HIS 

25 LETTER OF JUNE 5TH. THANK YOU. HAVE A GOOD DAY. 
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1

2 SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY. 

3 THAT CLOSES THE PUBLIC HEARING ON THOSE ITEMS. THERE IS 

4 ADDITIONAL REQUESTS BY SUPERVISOR KNABE TO CONTINUE ITEM 31 

5 FOR ONE WEEK. AND IF THERE ARE NO OBJECTIONS, THAT WILL BE THE 

6 ORDER. 

7

8 SUP. KNABE: WITH A REPORT BACK ON THOSE PARTICULAR ISSUES 

9 RAISED HERE TODAY. 

10

11 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHTY. THANKS, MUCH. MADAME 

12 EXECUTIVE OFFICER, THE BALANCE? 

13

14 SACHI HAMAI, EXEC. OFFICER: THANK YOU. THE FOLLOWING ITEMS ARE 

15 BEFORE YOUR BOARD. ITEM S-1, WILL BE CONTINUED TO DECEMBER 

16 3RD. ITEM 1-D IS BEFORE YOU. ITEM NO. 1. ITEM NO. 11 WILL BE 

17 CONTINUED TWO WEEKS. ITEM NO. 17 WILL BE CONTINUED TWO WEEKS. 

18 ITEM NO. 18 IS BEFORE YOUR BOARD, 19, 20, 21, 22, 23. ITEM 25 

19 WILL BE CONTINUED TWO WEEKS. ITEM NO. 36 WILL BE CONTINUED ONE 

20 WEEK. AND ITEM NO. 40 WILL BE REFERRED BACK TO THE SHERIFF'S 

21 DEPARTMENT. THOSE ITEMS ARE BEFORE YOU. 

22

23 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU VERY MUCH. 

24 THOSE ITEMS ARE BEFORE US. SUPERVISOR ANTONOVICH MOVES. 
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1 SUPERVISOR YAROSLAVSKY SECONDS. SEEING NO OBJECTIONS, PLEASE 

2 RECORD A UNANIMOUS VOTE. 

3

4 SACHI HAMAI, EXEC. OFFICER: THANK YOU. ITEM NO. 10, IF YOU'D 

5 LIKE TO CALL UP THAT ITEM? 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. IT IS BEFORE US. ITEM 

8 NO. 10 AND WE HAVE THREE PERSONS WISHING TO BE HEARD ON ITEM 

9 NO. 10. THEY ARE PAUL DUMONT, CHANTEL COUDOUX, AND JULIA MAI, 

10 IF YOU WOULD COME FORWARD ON ITEM NO. 10. 

11

12 PAUL DUMONT: GOOD MORNING, SUPERVISORS, MY NAME IS PAUL 

13 DUMONT, I'M A HOUSING ADVOCATE WITH THE SOBER LIVING NETWORK. 

14 WE'RE A NONPROFIT VOLUNTEER ORGANIZATION OVERSEEING MORE THAN 

15 300 HOMES IN LOS ANGELES COUNTY, PROVIDING SAFE AND SOBER 

16 HOUSING FOR THOUSANDS OF PEOPLE EVERY NIGHT. MANY OF OUR 

17 PEOPLE HAVE SUFFERED ABUSE IN LOS ANGELES COUNTY JAILS. OUR 

18 MEMBER HOMES MUST DEAL WITH THIS TRAUMA WHILE SEEKING TO 

19 REINTEGRATE EX-OFFENDERS. OUR INTEREST IN ADVOCATING FOR 

20 CIVILIAN OVERSIGHT AT THE JAILS IS TO MINIMIZE THE UNINTENDED 

21 IMPACTS OF INCARCERATION AND REDUCE VIOLENCE SUFFERED INSIDE 

22 THAT FRUSTRATES OUR MISSION TO PROVIDE QUALITY, SOBER LIVING 

23 ENVIRONMENTS UPON RELEASE. OFTEN NEWLY RELEASED PERSONS HAVE 

24 DIFFICULTY ADJUSTING TO LIFE IN THE FREE WORLD. THE WAY OF 

25 LIFE INSIDE CAN TRANSMIT TO AN ILL CONCEIVED PERCEPTION OF AN 
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1 ACCEPTABLE WAY OF LIFE OUTSIDE. REDUCING VIOLENCE BY AUTHORITY 

2 FIGURES INSIDE WILL INSTILL A CLEAR MESSAGE THAT VIOLENCE 

3 ANYWHERE IS UNACCEPTABLE. WHEN PROPER OVERSIGHT IS IMPLEMENTED 

4 AND VIOLENCE IN THE JAILS IS MINIMIZED, WE BELIEVE PUBLIC 

5 SAFETY WILL IMPROVE. TEACHING PRISONERS IT'S OKAY FOR 

6 GOVERNMENT TO CAGE AND BEAT PEOPLE WILL DEFINITELY RESULT IN 

7 MORE VIOLENT CRIME. IN LIGHT OF THE NUMEROUS INVESTIGATIONS 

8 AND SEEMINGLY DAILY REPORTS OF MISCONDUCT BY L.A.S.D. 

9 EMPLOYEES, PUBLIC CONFIDENCE DEMANDS PUBLIC OVERSIGHT. THERE 

10 CAN NEVER BE TOO MANY EYES AND EARS WATCHING HOW WE TREAT OUR 

11 PRISONERS. NEVER FORGET THAT SOCIETY IS MEASURED BY HOW IT 

12 TREATS ITS WEAKEST MEMBERS. THE SUPERVISORS HAVE BEEN LONG 

13 ADVOCATING FOR JAIL REFORMS AND CHAMPIONING HOMELESSNESS 

14 REDUCTION ISSUES, AND WE ENCOURAGE YOU TO SUPPORT THIS SMART 

15 APPROACH BY CREATING THE CITIZENS' OVERSIGHT COMMISSION TO 

16 REDUCE VIOLENCE IN THE JAILS. THANK YOU. 

17

18 SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY. 

19 WE'LL TAKE THE NEXT SPEAK EVER. 

20

21 CHANTAL COUDOUX: GOOD MORNING. 

22

23 SUP. RIDLEY-THOMAS, CHAIRMAN: MR. KRATTLI, IF YOU WOULD STOP 

24 DISTRACTING SUPERVISOR MOLINA, WE WOULD APPRECIATE IT. THANK 

25 YOU. PROCEED. 
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1

2 CHANTAL COUDOUX: GOOD MORNING, MY NAME IS CHANTAL COUDOUX AND 

3 I'M WITH THE COALITION TO END SHERIFF VIOLENCE IN L.A. JAILS. 

4 I WANTED TO CONTINUE TO THANK SUPERVISORS MARK RIDLEY-THOMAS 

5 AND GLORIA MOLINA FOR PUTTING FORTH THIS MOTION ON CIVILIAN 

6 OVERSIGHT. AND I WANTED TO ALSO SPEAK TO THE CONCERNS FROM 

7 OTHER MEMBERS OF THE BOARD, PARTICULARLY THAT THIS KIND OF 

8 BODY WAS NOT, IN FACT, PART OF THE FINDINGS OF THE BOARD-

9 RECOMMENDED CIVILIAN COMMISSION ON JAIL VIOLENCE, THE 

10 RECOMMENDATIONS. THE REPORT ACTUALLY SPECIFIED THAT AN 

11 OVERSIGHT BODY WAS, IN FACT, NECESSARY AND THAT THE BOARD 

12 COULD REMAIN THAT BODY IF THEY CONTINUE TO BE ENGAGED IN JAIL 

13 OVERSIGHT AND CONTINUE TO PUT SPOTLIGHTS ON THE JAILS. BUT AS 

14 EVIDENCED BY BOTH GLORIA MOLINA AND MARK RIDLEY-THOMAS'S 

15 CONCERN, AND MANY, MANY YEARS OF FINDINGS, DIFFERENT REPORTS, 

16 AND CERTAINLY THE C.C.J.V. FINDINGS OF CONTINUED 

17 MISMANAGEMENT, IT'S CLEAR THAT THE WIDE SCOPE OF THE BOARD'S 

18 RESPONSIBILITIES HAS LIMITED THE FULL ENGAGEMENT AND CAPACITY 

19 OF THE BOARD, WHICH IS WHY WE, THE COALITION AND A NUMBER OF 

20 OTHER COALITION PARTNERS BELIEVE THAT IT IS CRITICAL TO HAVE 

21 AN OVERSIGHT BODY, INDEPENDENT, WHOSE FOCUS CAN ACTUALLY BE ON 

22 THE JAILS. SO THANK YOU. AND WE LOOK FORWARD TO THE VOTE. 

23

24 SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY. 

25 WE'LL TAKE THE NEXT SPEAKER, PLEASE. 
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1

2 JULIA MAI: GOOD MORNING. MY NAME IS JULIA MAI. I'M WITH THE 

3 COALITION TO END SHERIFF VIOLENCE IN L.A. JAILS. AND I'M ALSO 

4 A STUDENT AT CAL STATE L.A. I HAVE BEEN COLLECTING INCIDENT 

5 FORMS FROM FORMERLY INCARCERATED PEOPLE DOCUMENTING THEIR 

6 EXPERIENCE INSIDE THE JAILS AND SPECIFICALLY DEALING WITH 

7 VIOLENCE. WE ARE VERY THANKFUL FOR THE MOTION PUT FORTH BY 

8 MARK-- SUPERVISORS MARK RIDLEY-THOMAS AND GLORIA MOLINA. AND 

9 SPECIFICALLY AS A STUDENT AT CAL STATE L.A., I'M THANKFUL THAT 

10 SUPERVISOR MOLINA OF OUR DISTRICT IS TAKING OUR PROPOSAL 

11 SERIOUSLY FOR A CIVILIAN OVERSIGHT BODY. HOWEVER, UNTIL IT IS 

12 IMPLEMENTED, WE KNOW AS CITIZENS WE MUST CONTINUE TO DO OUR 

13 OWN MONITORING OF THE JAILS AND COLLECT THE STORIES OF PEOPLE 

14 INSIDE. WITHOUT ACCOUNTABLE OVERSIGHT, PEOPLE'S STORIES GET 

15 LOST, AND WE AS CIVILIANS WILL NOT LET THIS HAPPEN. I URGE 

16 THIS BOARD TO SUPPORT THE CRITICAL MOTION WHEN IT IS UP FOR 

17 THE VOTE. IF YOU TAKE A LOOK AT OTHER EUROPEAN NATIONS' JAIL 

18 SYSTEMS AND COMPARE THEIR CRIME RATE STATISTICS WITH OURS, YOU 

19 WILL SEE HOW FLAWED OUR SYSTEM IS, EVEN IF WE CAN GET AN 

20 OVERSIGHT OF OUR JAILS. THIS IS JUST A STEP CLOSER TO CATCH UP 

21 TO THOSE MORE ADVANCED JAIL SYSTEMS. SO LET'S LOOK AT THOSE 

22 GREATER NATIONS AS GREAT EXAMPLES TO HELP US IMPROVE OUR 

23 COMMUNITIES. THANK YOU. 

24
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1 SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY. 

2 THAT MOTION HAS BEEN THAT THE MATTER HAS BEEN CONTINUED FOR 

3 THREE WEEKS, IS THAT THE CASE? 

4

5 SACHI HAMAI, EXEC. OFFICER: THAT'S CORRECT. 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. AND SO WE'LL LOOK 

8 FORWARD TO TAKING THE MATTER UP AT THAT POINT IN TIME. WE 

9 THANK YOU FOR YOUR TESTIMONY. AND WE'LL PROCEED TO THE NEXT 

10 ITEM ON THE AGENDA. 

11

12 SACHI HAMAI, EXEC. OFFICER: ITEM NO. 56 IS A REPORT? 

13

14 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. 

15

16 SACHI HAMAI, EXEC. OFFICER: THE C.E.O.'S OFFICE? 

17

18 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. ITEM NO. 56 

19 IS BEFORE US, MR. FUJIOKA? THERE'S ONE PERSON WHO WISHES TO BE 

20 HEARD. 

21

22 C.E.O. FUJIOKA: WOULD YOU LIKE ME TO SPEAK FIRST? 

23

24 SUP. RIDLEY-THOMAS, CHAIRMAN: YOU MAY. 

25



November 5, 2013

40

1 C.E.O. FUJIOKA: AT THE REQUEST OF THE BOARD AND IN FOLLOW UP 

2 TO A MOTION, WE DEVELOPED A PROCESS TO WORK WITH THE 

3 DEPARTMENT OF HEALTH SERVICES TO ENHANCE OUR MARKETING 

4 CAPABILITIES RELATED TO THE AFFORDABLE CARE ACT. WHAT WE HAVE 

5 IS SOME BASIC INFORMATION IN THIS REPORT THAT SPEAKS TO THE 

6 PLAN, WHAT THE DEPARTMENT IS DOING RIGHT NOW, BUT ALSO THERE'S 

7 A PROVISION THAT WOULD REQUIRE US TO COME BACK TO YOUR BOARD 

8 WHEN WE HAVE A VERY SPECIFIC EVENT IN MIND. IN CONSULTATION 

9 WITH OUR BOARD OFFICES, WE UNDERSTAND THAT NOT ONLY WILL WE 

10 GET INFORMATION FROM THE BOARD ON EVENTS THAT THEY'RE AWARE OF 

11 IN THIS SPECIFIC DISTRICT, BUT WE'VE ALSO BEEN ASKED TO 

12 COMPILE A LIST OF POTENTIAL-- NOT POTENTIAL, BUT SCHEDULED 

13 MAJOR EVENTS THAT ARE HELD ON AN ANNUAL BASIS IN OUR COUNTY. 

14 AND THAT COULD INCLUDE-- WELL, I'LL JUST DEAL WITH THAT, WITH 

15 MAJOR EVENTS. AND WE'RE IN THE PROCESS OF DOING SO. BUT ONCE 

16 WE HAVE THAT LIST COMPILED BOTH WITH INPUT FROM THE BOARD AND 

17 THE LIST OF THE MAJOR EVENTS, WE'LL BE COMING BACK TO YOUR 

18 BOARD IN THE FUTURE WITH SPECIFIC PLANS ON WHERE WE SHOULD GO, 

19 WHAT WILL OUR PARTICIPATION CONSIST OF AND WHETHER OR NOT 

20 THERE'S ANY EXPENDITURE OF FUNDS FOR YOUR SPECIFIC APPROVAL. 

21 THAT'S ESSENTIALLY IT. THANK YOU VERY MUCH. 

22

23 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. WE NOTE ON ITEM 6 

24 THAT ERIC PREVEN WISHES TO BE HEARD. 5, 6. I'M SORRY? MR. 

25 PREVEN, THE CHIEF EXECUTIVE OFFICER JUST SPENT THE LAST THREE 
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1 MINUTES GIVING THE REPORT. I'M SORRY? YOU'RE PASSING? ALL 

2 RIGHT. MEMBERS OF THE BOARD, ARE THERE ANY QUESTIONS OR 

3 COMMENTS YOU WISH TO RAISE? LET ME JUST OFFER THE FOLLOWING 

4 PURSUANT TO THIS MOTION. D.H.S. APPRISED US OF THE FOLLOWING: 

5 THE AFFORDABLE CARE ACT MEANS A LIFELINE TO MOST OF THE 1.7 

6 MILLION UNINSURED PEOPLE IN L.A. COUNTY OF THE AFFORDABLE CARE 

7 ACT MEANS THAT APPROXIMATELY 780,000 CAN QUALIFY FOR SOME TYPE 

8 OF SUBSIDY. AN ADDITIONAL 390,000 PEOPLE WILL BE ELIGIBLE FOR 

9 NEW MEDI-CAL EXPANSION. IN OTHER WORDS, IN THE SIMPLEST TERMS, 

10 THIS MEANS THE AFFORDABLE CARE ACT WILL HELP 7 OUT OF EVERY 10 

11 UNINSURED PERSONS IN L.A. COUNTY. THIS IS WHY IT IS OFTEN 

12 DESCRIBED AS A LIFELINE THAT CAN MAKE A QUALITATIVE DIFFERENCE 

13 IN THE LIVES OF MANY, MANY OF OUR RESIDENTS. THE MATH ISN'T 

14 BAD IN TERMS OF HOW IT HELPS OUR COUNTY WITH REVENUES, THEN, 

15 ARE GENERATED THAT TAKE THE BURDEN OFF OF TAXPAYERS DIRECTLY 

16 IN TERMS OF THAT WHICH GOES INTO EMERGENCY SERVICES AS MANY OF 

17 THESE INDIVIDUALS USE EMERGENCY ROOMS IN OUR SYSTEM AS NOT 

18 ONLY A LAST RESORT BUT IN MANY INSTANCES FIRST RESORT. AND SO 

19 IT SEEMS TO ME THAT AN APPROPRIATE MARKETING PLAN, APPROPRIATE 

20 OUTREACH IS IN ORDER. AND THERE ARE ANY NUMBER OF 

21 OPPORTUNITIES COUNTY-WIDE. WE HAVE UP UNTIL APRIL OF NEXT YEAR 

22 TO DO THIS WORK. AND EACH OF US WOULD HAVE MAJOR EVENTS IN OUR 

23 DISTRICT, OUR RESPECTIVE DISTRICTS, TO MAKE SURE THAT OUR 

24 DEPARTMENTS THAT COULD BE D.H.S., AS WELL AS D.P.S.S. AS WELL 

25 AS D.P.H., ALL MUCH THESE DEPARTMENTS HAVE A ROLE TO PLAY AT 
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1 THESE MAJOR EVENTS. IT'S GOOD FOR US. AND SO THE MEMO THAT'S 

2 BEFORE US IS, I THINK, AN ATTEMPT TO TEE UP THE MATTER AND GET 

3 THE ATTENTION OF EACH OF US AS WELL AS OUR RESPECTIVE OFFICES 

4 SO THAT WE CAN TAKE FULL ADVANTAGE OF THIS OPPORTUNITY 

5 THROUGHOUT THE COUNTY, NOT ONE PARTICULAR ASPECT OF THE 

6 COUNTY, BUT THROUGHOUT THE COUNTY. SO WE'LL LOOK FORWARD TO A 

7 FOLLOW UP REPORT. MR. FUJIOKA, WHEN WILL THAT BE COMING BACK 

8 TO THE BOARD? 

9

10 C.E.O. FUJIOKA: OH, IT WASN'T ON. I APOLOGIZE. WITHIN THE NEXT 

11 30 DAYS. 

12

13 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. SO BY THE END OF THE 

14 MONTH, THE FIRST OF NEXT MONTH, WE SHOULD HEAR A FOLLOW UP 

15 REPORT, PRESUMABLY FULLER WITH SPECIFIC IDEAS AS TO WHAT 

16 VENUES, EVENTS WILL MAKE DISTRICT-- THAT IS COUNTY-WIDE IMPACT 

17 IN TERMS OF OUR RECRUITING. I WANT TO INDICATE AT CARE HARBOR 

18 THIS PAST WEEK, THE DATA IS STILL COMING IN IN TERMS OF HOW 

19 SUCCESSFUL THAT EVENT WAS IN TERMS OF THE NUMBER OF PERSONS 

20 WHO DID ENROLL. AND IN YOUR NEXT REPORT, MR. FUJIOKA, I WOULD 

21 HOPE THAT THAT DATA COULD BE INCLUDED AS AN EXAMPLE OF WHAT 

22 OPPORTUNITIES THERE ARE TO BE TAKEN ADVANTAGE OF. 

23

24 C.E.O. FUJIOKA: WE CAN DO THAT. I DIDN'T WANT TO READ THE 

25 WRITTEN REPORT WE SENT YOU, BUT D.H.S. HAS A FAIRLY 
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1 COMPREHENSIVE PROGRAM RIGHT NOW, SO WE'LL EXPAND ON WHAT 

2 THEY'RE DOING AND WE'LL GIVE YOU INFORMATION ON THE RESULTS 

3 AND BENEFITS OF THEIR EFFORTS. 

4

5 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU. 

6

7 SUP. KNABE: MR. CHAIRMAN, I WOULD JUST ADD, THAT'S A REALLY 

8 IMPORTANT PIECE OF THIS, BECAUSE OTHERWISE EVERYONE THINKS 

9 THAT EVERYONE IS GOING TO BE INSURED AND THEY'RE NOT. WE TRULY 

10 COULD BE LEFT WITH A NON-PAYING CLIENT IF WE DON'T BE 

11 AGGRESSIVE WITH OUR MARKETING PROGRAM. 

12

13 SUP. ANTONOVICH: MR. CHAIRMAN, N.B.C. JUST REVEALED THIS LAST 

14 WEEK THAT THE NEW REGULATIONS WILL PREVENT THE GRANDFATHERING 

15 OF UP TO EXISTING 15 MILLION HEALTH CARE PLANS FOR 

16 INDIVIDUALS, ELIMINATING AN EXISTING HEALTH PLAN TO BUY A 

17 HIGHER PLAN WITH HIGHER PREMIUMS AND DEDUCTIBLES FOR SERVICES 

18 NOT NEEDED. NEXT YEAR, MORE THAN 90 MILLION EMPLOYER-SPONSORED 

19 HEALTH PLANS WILL BE HIT WITH THE SAME TYPE OF PUNITIVE 

20 REGULATIONS. I WOULD HOPE THAT THE REPORT BACK INCLUDES SOME 

21 OF THE IMPACTS THAT ARE OCCURRING CURRENTLY WITH THOSE WHO 

22 HAVE INSURANCE AND ALSO A NUMBER OF THE HOSPITALS AND PRIVATE 

23 BUSINESSES WHO ARE TAKING THE 40-HOUR WORKWEEK AND REDUCING 

24 THEIR EMPLOYEES TO A LESS THAN THE 40-HOUR WORKWEEK BECAUSE OF 
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1 THE HEALTH CARE IMPACT THAT IT IS HAVING ON THEIR EMPLOYEES, 

2 IF THAT COULD BE PART OF THAT, AS WELL. 

3

4 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. I SIMPLY WANT TO SAY, 

5 AGAIN, ACCORDING TO-- 

6

7 SUP. ANTONOVICH: THE IMPACT ON MEDICAID, FOOD STAMPS. 

8

9 SUP. RIDLEY-THOMAS, CHAIRMAN: THE IMPACT ON MEDICAID, ANYTHING 

10 FURTHER, SUPERVISOR ANTONOVICH? IT IS PROBABLY USEFUL ON A 

11 MONTHLY BASIS, WE'VE HAD REPORTS FROM THE DIRECTOR OF THE 

12 DEPARTMENT OF HEALTH SERVICES IN TERMS OF OUR READINESS FOR 

13 THE IMPLEMENTATION OF THE A.C.A. MY VIEW IS SIMPLE. WE SHOULD 

14 CONTINUE THAT UPDATE NOW THAT WE'RE IN IT. WE SHOULD LEARN 

15 MORE ABOUT ENROLLMENT. WE SHOULD LEARN AS MUCH AS WE CAN ABOUT 

16 COVERED CALIFORNIA. AND WE SHOULD GET TO THE BOTTOM OF THE 

17 FACT THAT THERE IS A STRONG ARGUMENT TO BE MADE, THESE DATA 

18 COME FROM THE DEPARTMENT OF HEALTH SERVICES THAT SOME 7 OUT OF 

19 EVERY 10 UNINSURED PERSONS IN L.A. COUNTY COULD, THAT IS 

20 LIKELY TO BE BENEFITED BY THE AFFORDABLE CARE ACT. THAT'S GOOD 

21 NEWS, PLENTY GOOD NEWS, NOT ONLY TO THE INDIVIDUALS, BUT IT IS 

22 TO THE FISCAL HEALTH OF THE COUNTY ITSELF. AND SO IN YOUR 

23 REPORT BACK, OBVIOUSLY, SUPERVISOR ANTONOVICH WISHES TO SHINE 

24 A LIGHT AND OFFER CRITIQUE ON THE A.C.A. I WOULD SIMPLY 

25 REQUEST THAT WE COME FULL FORCE WITH ALL THE DATA THAT WE HAVE 
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1 IN TERMS OF THE POTENTIAL, IN THE FAVORABLE WAY THAT IT 

2 IMPORTANT TENDS TO NOT ONLY THE INDIVIDUALS IN THIS COUNTY BUT 

3 THE COUNTY ITSELF FROM A FISCAL POINT OF VIEW. AND SO IF THAT 

4 COULD BE INCLUDED IN YOUR REPORT, IT WOULD BE GREATLY 

5 APPRECIATED. AND IF THERE'S A NEED FOR FURTHER CLARIFICATION, 

6 WE CAN FOLLOW UP WITH THE WRITTEN COMMUNICATION TO THAT 

7 EFFECT. WHAT IS YOUR PLEASURE, MR. FUJIOKA? 

8

9 C.E.O. FUJIOKA: I UNDERSTAND WHAT'S BEING REQUESTED. WHAT WELL 

10 DO IS WE'LL FOLLOW UP WITH A SINGLE REPORT, BUT WE'LL ALSO 

11 WORK WITH OUR DIRECTOR OF HEALTH SERVICES TO INSURE THAT HIS 

12 MONTHLY REPORT CONTINUES ON AN ONGOING BASIS THE REPORT OF THE 

13 MARKETING EFFORTS, NOT ONLY JUST THE MARKETING EFFORTS BUT 

14 WHETHER OR NOT WE'VE BEEN SUCCESSFUL. OKAY? 

15

16 SUP. RIDLEY-THOMAS, CHAIRMAN: EXCELLENT. THANK YOU. 

17

18 C.E.O. FUJIOKA: THANK YOU, SIR. 

19

20 SUP. RIDLEY-THOMAS, CHAIRMAN: ANY FURTHER DISCUSSION ON THIS? 

21 SUPERVISOR YAROSLAVSKY? 

22

23 SUP. YAROSLAVSKY: QUESTION, MR. FUJIOKA. ANY EXPENDITURE 

24 TOWARD ANY OF THESE PROGRAMS OTHER THAN INTERNAL 
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1 ADMINISTRATIVE OBLIGATIONS THAT THE DEPARTMENT MAY HAVE WOULD 

2 HAVE TO COME BACK TO THIS BOARD STILL. 

3

4 C.E.O. FUJIOKA: ABSOLUTELY. WE'LL BRING THEM BACK. 

5

6 SUP. YAROSLAVSKY: I REALLY BELIEVE THAT MOST OF THE COMMUNITY-

7 BASED ORGANIZATIONS, IF NOT ALL OF THEM, WOULD MAKE THEIR 

8 BOOTHS AND THEIR INFRASTRUCTURE AVAILABLE FOR US TO BE THERE 

9 AS A COMMUNITY SERVICE. WE SHOULDN'T BE UNDERWRITING PROGRAMS 

10 THAT ALREADY EXIST. I HAVE SEVERAL OF THOSE IN MY DISTRICT. 

11 AND I WOULD NOT FEIGN TO UNDERWRITE THEM. BUT I THINK THEY 

12 WOULD BE MORE THAN WILLING TO ACCOMMODATE US. NOW, IF SOMEBODY 

13 WANTS TO DO A SPECIAL PROGRAM JUST FOR THIS PURPOSE, LIKE THE 

14 MEDICAL PROGRAM AT THE SPORTS ARENA, WHICH I DON'T KNOW IF WE 

15 UNDERWRITE THAT THEN TO EXTEND OR NOT. 

16

17 SUP. RIDLEY-THOMAS, CHAIRMAN: I DO. 

18

19 SUP. YAROSLAVSKY: IT'S A VERY SUCCESSFUL PROGRAM. BUT FOR THIS 

20 PURPOSE, FOR OUTREACH ON THIS PURPOSE EXCLUSIVELY THAT WOULD 

21 BE A DIFFERENT STORY. BUT I THINK THERE ARE A LOT OF FAIRS OUT 

22 THERE. A LOT OF FARMERS' MARKETS. A LOT OF THANKSGIVING TURKEY 

23 GIVE-AWAYS WE HAVE ALL OVER THE COUNTY, AND WE OUGHT TO BE AT 

24 ALL OF THOSE PLACES WITH ALL WITH OUR PERSONNEL. THANK YOU. 

25
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1 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. ONCE AGAIN, I THINK 

2 AN ASSERTIVE MARKETING PLAN IS IN THE INTEREST OF THE 

3 INDIVIDUALS. AND I SHARE THE POINT OF VIEW THAT THERE IS STILL 

4 A LOT OF INFORMATION THAT NEEDS TO BE SHARED IN TERMS OF 

5 EDUCATING PEOPLE ABOUT THE BENEFITS OF THE REFORM AS IT IS 

6 ROLLING OUT. AND THIS IS A BIG COUNTY. WE OUGHT TO BE 

7 ASSERTIVE. AND TO THE EXTENT THAT WE CAN BE, I THINK IT'S 

8 ULTIMATELY IN THE BEST INTEREST OF THE COUNTY AS A WHOLE. I'VE 

9 SAID THAT REPEATEDLY. I WANT TO STATE IT, AND FROM MY POINT OF 

10 VIEW, IF THE RESOURCES HAVE AVAILABLE TO FACILITATE THAT, AS 

11 LONG AS IT COMES BACK TO THE BOARD FOR APPROVAL PURSUANT TO 

12 THE MOTION, THEN I WOULD BE AN AYE VOTE FOR IT. I AM NOT GOING 

13 TO SUBSTITUTE MY JUDGMENT AS TO WHETHER OR NOT ENTITIES SHOULD 

14 OR SHOULD NOT BE SUPPORTED, UNDERWRITTEN IF IT COMES HERE TO 

15 THE BOARD FOR APPROVAL AND GARNERS THREE VOTES, SUCH SHOULD BE 

16 THE CASE. NEXT ITEM, PLEASE. 

17

18 SACHI HAMAI, EXEC. OFFICER: ON THIS ITEM, MR. CHAIRMAN, 

19 SUPERVISOR ANTONOVICH, I BELIEVE, IS A NO VOTE. AND I BELIEVE 

20 WE ARE RECEIVING AND FILING THE REPORT. 

21

22 SUP. RIDLEY-THOMAS, CHAIRMAN: YES. THANK YOU. 

23

24 SACHI HAMAI, EXEC. OFFICER: THANK YOU. THE NEXT ITEM, 

25 SUPERVISOR KNABE IS HOLDING ITEM NO. 32.  
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1

2 SUP. RIDLEY-THOMAS: SUPERVISOR? 

3

4 SUP. KNABE: I'M JUST CURIOUS. OBVIOUSLY THIS IS A HUGE ISSUE 

5 FOR US AND A VERY IMPORTANT PIECE OF BEING PREPARED FOR THE 

6 A.C.A. AND EVERYTHING ELSE. DID WE EVER USE J.O.C.S FOR THIS 

7 SIZE OF A CONTRACT BEFORE? 

8

9 SPEAKER: SUPERVISOR, THE IMPORTANT THING TO UNDERSTAND ABOUT 

10 THE ELECTRONIC HEALTH RECORDS IS THE ESTIMATED CONSTRUCTION 

11 VALUE IS ABOUT $45 MILLION, BUT THAT'S ACTUALLY SPREAD ACROSS 

12 ABOUT 60 DIFFERENT BUILDINGS IN OUR CLINICS AND HOSPITALS. SO 

13 EACH INCREMENT OF WORK IS RELATIVELY SMALL. THE LARGEST SINGLE 

14 WORK IN ONE BUILDING IS IN THE TOWER AT HARBOR-U.C.L.A., AND 

15 THAT'S ABOUT $4 MILLION. 

16

17 SUP. KNABE: I MEAN, I'M ALWAYS CONCERNED ABOUT CHANGE ORDERS 

18 AND DISPUTES AND OBVIOUSLY RUNNING ACROSS THAT MANY DIFFERENT 

19 BUILDINGS. I WANT TO MAKE SURE THAT WHATEVER WE DO OR HOWEVER 

20 WE DO IT ALLOWS US THE OPPORTUNITY TO MAKE SURE WE DON'T GET 

21 STUCK. 

22

23 SPEAKER: ABSOLUTELY. WHEN PUBLIC WORKS FIRST CAME INTO THE 

24 ELECTRONIC HEALTHCARE RECORDS PROGRAM BACK IN JANUARY, ONE OF 

25 THE FIRST THINGS WE LOOKED AT WHEN WE UNDERSTOOD THE SCOPE IS 
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1 WHAT WOULD BE THE BEST CONTRACTING STRATEGY? AND ONE OF THE 

2 THINGS WE WERE CONCERNED ABOUT IS EXACTLY WHAT YOU WERE SAYING 

3 IN TERMS OF MANAGING THE COUNTY'S COSTS, MANAGING RISK OF 

4 CHANGE, CLAIMS, THOSE TYPES OF THINGS. AND J.O.C.S IS 

5 ACTUALLY, OF THE DIFFERENT CONTRACTING METHODS THAT WE HAVE 

6 AVAILABLE TO US LEGALLY, IS THE ONE THAT'S BEST SUITED TO THIS 

7 TYPE OF AN ENVIRONMENT. 

8

9 SUP. KNABE: I HEARD, OR YOU INDICATED THAT IT WOULD LEAD TO 

10 FEWER DISPUTES AND LESS COSTLY CLAIMS. BUT WITH A MULTITUDE OF 

11 CONTRACTS AND POTENTIAL CONTRACTORS, HOW COULD THAT BE? I MEAN 

12 YOU GOT MOVING TARGETS. 

13

14 SPEAKER: SURE. BASICALLY, AGAIN, AS WE REPORT TO THE BOARD, WE 

15 LOOK AT THE ELECTRONIC HEALTH RECORDS AS A PROGRAM. AND WE 

16 GIVE YOU THAT INFORMATION. BUT IT'S ACTUALLY GOING TO BE 

17 BROKEN DOWN ACROSS THOSE BUILDINGS, NUMEROUS DIFFERENT 

18 BUILDING PERMITS AND BID PACKAGES. I'VE ORGANIZED MY TEAM WITH 

19 NUMEROUS DIFFERENT PROJECT MANAGERS. SO WE'RE LOOKING AT THE 

20 INDIVIDUAL COMPONENTS. AND EACH ONE OF THOSE WILL HAVE ITS OWN 

21 PROJECT CONTROLS BUDGET COSTS, ET CETERA. AND SO DIFFERENT 

22 J.O.C.S. CONTRACTS WILL BE ASSIGNED TO DIFFERENT CLINICS OR 

23 HOSPITALS. AND EACH ONE WILL BE MANAGED SEPARATELY. WE THINK-- 

24 BASICALLY THE ENEMY WE WOULD RUN INTO IS UNFORESEEN 

25 CONDITIONS. AND IF WE WENT WITH EITHER DESIGN BUILD OR DESIGN 
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1 BID BUILD, WE WOULD-- THERE'S JUST UNQUESTIONABLY GOING TO BE 

2 THINGS THAT WE ENCOUNTER WHEN WE OPEN THE WALLS, OPERATIONAL 

3 ISSUES THAT THE DEPARTMENT NEEDS US TO ACCOMMODATE, AND THOSE 

4 WILL IMMEDIATELY THROW A DESIGN BUILD OR DESIGN BID BUILD 

5 CONTRACTOR INTO DELAYS AND CLAIMS AND DISPUTES, WHEREAS THE 

6 J.O.C.S. IS SET UP ON UNIT PRICE SO THAT IF WE HAVE TO CHANGE 

7 AN ITEM OF SCOPE OR ADD SOMETHING, WE'VE ALREADY GOT A FIXED 

8 PRICE FOR THAT. WE AUTHORIZE JUST THAT WORK, AND WE DON'T PAY 

9 FOR RIPPLING IMPACTS AND DELAY CLAIMS. SO, REALLY, IT'S THE 

10 IDEAL TOOL FOR THIS ENVIRONMENT. 

11

12 SUP. KNABE: THANK YOU. 

13

14 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. ANYTHING MORE ON ITEM 

15 NO. 32 AT THIS POINT? SEEING NO FURTHER DISCUSSION, SUPERVISOR 

16 KNABE MOVES. SUPERVISOR ANTONOVICH SECONDS, AND WE RECORD A 

17 UNANIMOUS VOTE ON THAT ITEM. MADAME EXECUTIVE OFFICER? 

18

19 SACHI HAMAI, EXEC. OFFICER: IF YOU'D LIKE TO TAKE UP 

20 ADJOURNMENTS? 

21

22 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. WE BEGIN WITH 

23 DISTRICT 3. SUPERVISOR YAROSLAVSKY? 

24
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1 SUP. YAROSLAVSKY: I'LL ASK THAT WE ADJOURN IN THE MEMORY OF 

2 CHRIS SHEBEL WHO PASSED AWAY OVER THIS PAST WEEKEND. CHRIS WAS 

3 A VERY ACTIVE RESIDENT AND CITIZEN OF HOLLYWOOD, MORE ACTIVE 

4 WITH THE CITY THAN WITH THE COUNTY. SHE PASSED AWAY AFTER A 

5 LONG ILLNESS. SHE IS SURVIVED BY HER DAUGHTER, JACKIE. AND 

6 I'LL GET THE INFORMATION TO THE BOARD OFFICE, THE BOARD 

7 SECRETARY'S OFFICE SHORTLY. 

8

9 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU. SUPERVISOR 

10 KNABE, PLEASE? ADJOURNING MOTIONS. SUPERVISOR YAROSLAVSKY FOR 

11 ONE MORE. 

12

13 SUP. YAROSLAVSKY: JACKIE SHEBEL IS SURVIVED BY HER DAUGHTERS, 

14 JACKIE AND PATRICIA AND GRANDSON RYCE. I'D ALSO LIKE TO ASK 

15 THAT WE ADJOURN IN THE MEMORY OF JOHN KAUFER, WRITER AND 

16 DIRECTOR, WHO PASSED AWAY LAST MONTH IN A CAR ACCIDENT WHILE 

17 DRIVING BACK HOME FROM LAS VEGAS. HE WAS 58. HE WAS AN L.A.-

18 BASED FILMMAKER, GOT HIS START IN HIS LATE TEENS WHILE 

19 ATTENDING SARAH LAWRENCE COLLEGE. WHEN HE WAS HIRED TO WRITE 

20 FOR A.B.C.'S "MORK AND MINDY." HE LATER WROTE EPISODES OF 

21 A.B.C.'S "HOLMES" AND "YOYO", N.B.C.'S "QUARK" AND H.B.O.'S 

22 "DREAM ON" AS WELL AS REWRITES FOR VARIOUS MOTION PICTURES. HE 

23 WAS INVOLVED IN MANY MOTION PICTURES. HE WAS MARRIED TO 

24 ACTRESS PIA ZADORA FROM 1995 TO 2001 WITH WHOM THEY HAD A SON, 

25 JORDAN. IN ADDITION TO JORDAN, HE'S SURVIVED BY HIS BROTHER 
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1 SCOTT, ALSO A T.V. WRITER AND PRODUCER, HIS FATHER MACK, A 

2 COMMUNITY LEADER IN WEST LOS ANGELES AND LONGTIME CHAIRMAN OF 

3 THE BOARD OF MENORAH HOUSING FOUNDATION. AND ALSO HE'S 

4 SURVIVED BY HIS MOTHER JIMMIE AND SISTER SUSAN. THAT'S IT. 

5

6 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU. SUPERVISOR 

7 KNABE, PLEASE. 

8

9 SUP. KNABE: YES. I MOVE THAT WE ADJOURN IN MEMORY OF M.T. 

10 GULER, I BELIEVE IT IS, MOTHER OF MY FORMER STAFF MEMBER TIM 

11 RILEY, PASSED AWAY PEACEFULLY AFTER A VERY LONG ILLNESS. SHE 

12 WAS A NATIVE OF WILMINGTON, DELAWARE, LONGTIME RESIDENT OF 

13 KLOSTERS, SWITZERLAND. SHE LEAVES BEHIND HER THREE CHILDREN, 

14 TIM, KEVIN, ANNEMARIE, FIVE GRANDCHILDREN AND TWO GREAT 

15 GRANDCHILDREN. SHE WILL BE SORELY MISSED BY HER FAMILY AND 

16 FRIENDS. ALSO WE ADJOURN IN MEMORY OF ROBERT WARREN CLAYTON, 

17 KNOWN TO FAMILY AND FRIENDS IN THE LAKEWOOD AREA AS BOB. 

18 PASSED AWAY AT THE AGE OF 85. HE WAS BORN IN LOS ANGELES AND 

19 MARRIED TO HIS BELOVED WIFE RUTH FOR 64 YEARS. THEY LIVED IN 

20 LAKEWOOD, RAISED THREE CHILDREN, HAVE SIX GRANDCHILDREN, FIVE 

21 GREAT GRANDCHILDREN. BOB JOINED THE UNITED STATES NAVY AT AGE 

22 17, WAS AN ACTIVE MEMBER OF HIS CHURCH AND THE BELLFLOWER ELKS 

23 CLUB. SURVIVED BY WIFE RUTH, THREE CHILDREN, SIX GRANDCHILDREN 

24 AND FIVE GREAT GRANDCHILDREN. WILL BE SORELY MISSED BY ALL WHO 

25 KNEW HIM. THOSE ARE MY ADJOURNMENTS. 
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1

2 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, SUPERVISOR. 

3 SUPERVISOR ANTONOVICH, PLEASE. 

4

5 SUP. ANTONOVICH: MR. CHAIRMAN, MEMBERS, I WOULD LIKE TO HAVE 

6 ALL MEMBERS ON THIS ADJOURNMENT MOTION FOR GERARDO HERNANDEZ 

7 WHO WAS A RESIDENT OF PORTO RANCH IN THE SAN FERNANDO VALLEY 

8 WHO TRAGICALLY LOST HIS LIFE ON NOVEMBER 1ST DURING THE 

9 SHOOTING RAMPAGE AT THE LOS ANGELES INTERNATIONAL AIRPORT. 

10

11 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL MEMBERS. 

12

13 SUP. ANTONOVICH: ALL MEMBERS. HE WAS 39 YEARS OLD. HE WAS A 

14 NATIVE OF EL SALVADOR. HE WAS THE YOUNGEST OF FOUR BOYS MOVING 

15 TO THE UNITED STATES WHEN HE WAS 15 YEARS OF AGE. HE WAS A 

16 TRANSPORTATION SECURITY ADMINISTRATION OFFICER FOR FIVE YEARS 

17 AND HE WAS QUITE INVOLVED WITH GROWING HIS JOB AND HIS FAMILY. 

18 HE WAS ONE OF T.S.A.'S BEHAVIORAL DETECTION OFFICERS WHO WAS 

19 STATIONED THROUGHOUT THE AIRPORT LOOKING FOR SUSPICIOUS 

20 BEHAVIOR. HE IS SURVIVED BY HIS WIFE ANA AND THEIR TWO 

21 CHILDREN AND HIS THREE SIBLINGS. ALSO IN MEMORY OF KAY KIYOKO 

22 KUMAI [KIYOKO KAY KOMAI], WHO PASSED AWAY AT THE AGE OF 92. 

23 SHE WAS LONGTIME RESIDENT OF TEMPLE CITY. SHE AND HER FAMILY 

24 WERE CONFINED IN A JAPANESE IMPRISONMENT CAMP IN COLORADO 

25 DURING WORLD WAR II. AFTER THE WAR, SHE AND HER HUSBAND CON 
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1 OPENED THE KOMAI BONSAI NURSERY IN TEMPLE CITY WHICH HELPED 

2 POPULARIZE THE ANCIENT JAPANESE ART OF MINIATURE TREE 

3 CULTIVATION. I HAD AN OPPORTUNITY OF VISITING THEIR VARIOUS 

4 CELEBRATIONS THAT THEY HAD, THEIR ASSOCIATION, BECAUSE CON WAS 

5 A PRESIDENT AT THE ARBORETUM AND OTHER PLACES THROUGHOUT, THE 

6 YEARS BECAUSE KAY WAS ALSO THE SECRETARY TO THE ASSOCIATED 

7 STUDENT BODY OFFICE IN CHARGE OF ALL OF THE STUDENT BODY 

8 OFFICERS, THE MANAGER OF THE STUDENT UNION AT THE CALIFORNIA 

9 STATE UNIVERSITY OF LOS ANGELES. SHE WAS ALSO THE SPONSOR OF 

10 THE KAPPA ZETA PHI SORORITY FOR JAPANESE AMERICAN WOMEN AND 

11 HELPED WITH THE ALPHA PHI OMEGA SERVICE FRATERNITY. SHE ALSO 

12 HELPED CREATE THE SANTA ANITA BONSAI SOCIETY, THE SUZUKI 

13 AZALEA BONSAI SOCIETY AND THE GOLDEN STATE BONSAI FEDERATION. 

14 BUT SHE WAS A WONDERFUL ROLE MODEL. SHE KEPT IN TOUCH WITH 

15 STEVE COOLEY, WHO WAS ALSO A FELLOW STUDENT BODY OFFICER, 

16 WILLIS EDWARDS, WHO ANY OF YOU IN THE PAST, A STUDENT BODY 

17 OFFICER, WE ALL WERE TOUCHED WITH HER THROUGHOUT HER, UNTIL 

18 SHE PASSED AWAY. AND SHE WAS A WONDERFUL ROLE MODEL. ALSO WE 

19 HAVE CONCETTA "CONNIE" ANN ACQUAVIVA, LONGTIME RESIDENT OF 

20 SANTA CLARITA VALLEY WHO PASSED AWAY AT THE AGE OF 70. SHE WAS 

21 THE SECRETARY TO LOS ANGELES HIGH SCHOOL FOR THE ARTS AND 

22 SERVED FOR MANY YEARS IN THE PARISH OF ST. CLARE IN CANYON 

23 COUNTRY. SHE IS SURVIVED BY HER HUSBAND DICK AND THEIR FIVE 

24 CHILDREN. ROLAND CARRIVEAU, JR. OF SANTA CLARITA VALLEY PASSED 

25 AWAY AT THE AGE OF 63. HE WAS A TOASTMASTER, BUSINESSMAN AND 
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1 SERVED IN THE UNITED STATES MARINE CORPS. DR. GEORGE GAMBOA, 

2 LONGTIME RESIDENT OF ARCADIA, PASSED AWAY AT THE AGE OF 89. HE 

3 WAS AN ORAL SURGEON FOR 40 YEARS AND CLINICAL PROFESSOR AT THE 

4 UNIVERSITY OF SOUTHERN CALIFORNIA AND LOMA LINDA UNIVERSITIES, 

5 AND HE'S SURVIVED BY HIS WIFE AND HIS CHILDREN. COBEY 

6 KAWASAKI, RESIDENT OF SANTA CLARITA VALLEY, PASSED AWAY 

7 TRAGICALLY AT THE AGE OF 11. HE WAS A SIXTH GRADER AT LEONA 

8 COX SCHOOL, A YOUNG BOY WHO TOUCHED MANY LIVES, WHO LOVED 

9 FOOTBALL AND BASKETBALL. AND HE IS SURVIVED BY HIS PARENTS, 

10 GREG AND NORA AND HIS SISTER COURTNEY. WILLIAM MCCOMAS, 

11 SERGEANT, RETIRED, LOS ANGELES COUNTY SHERIFF'S DEPARTMENT. 

12 HIS LAST ASSIGNMENT WAS THE HOMICIDE BUREAU. DALE SEKOVICH, 

13 LONGTIME RESIDENT OF GLENDALE, PASSED AWAY AT THE AGE OF 65 ON 

14 JULY 16TH. HE HAD WORKED FOR THE FEDERAL TRADE COMMISSION FOR 

15 THE PAST 33 YEARS, A GRADUATE OF U.S.C., ON THE ROWING TEAM, 

16 ALONG WITH AN AVID BACKPACKER. HIS MOM, DIANE AND NIKA 

17 SEKOVICH WERE QUITE ACTIVE IN GLENDALE COMMUNITY AND ALSO 

18 STRONG VOLUNTEERS AT ALL OF MY POLITICAL EFFORTS. SO THOSE ARE 

19 MY ADJOURNMENTS. OH, EXCUSE ME. SHARON FEDERATION PASSED AWAY 

20 LAST WEEK. SHE WAS A NURSE AT OUR JUVENILE COURT MENTAL HEALTH 

21 PROGRAM, PERFORMING MENTAL HEALTH ASSESSMENTS AND GATHERING 

22 INFORMATION ON MEDICAL PROVIDERS, SCHOOLS AND ADULTS. THOSE 

23 WHO ARE INVOLVED WITH THE CARE OF OUR CHILDREN. SHE BEGAN HER 

24 CAREER WITH THE DEPARTMENT OF MENTAL HEALTH IN 1986 AS A 

25 MENTAL HEALTH COUNSELOR AND WAS LATER PROMOTED TO SENIOR 
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1 MENTAL HEALTH COUNSELOR IN APRIL 2000. SHE WORKED FOR MANY 

2 YEARS IN LONG BEACH CHILD AND ADOLESCENT MENTAL HEALTH PROGRAM 

3 PROVIDING INDIVIDUAL FAMILY AND GROUP SERVICES TO CLIENTS. SHE 

4 IS SURVIVED BY HER DAUGHTER SARAH AND HER BROTHER, BRUCE. 

5 THOSE ARE MY ADJOURNMENT MOTIONS, MR. CHAIRMAN. 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU, SUPERVISOR. 

8 SUPERVISOR MOLINA, PLEASE? 

9

10 SUP. MOLINA: THANK YOU. I'D LIKE TO ASK THAT WE ADJOURN IN THE 

11 MEMORY OF LONGTIME EAST LOS ANGELES RESIDENT ROSEMARY PINNEY, 

12 ONE OF MY DISTRICT'S MOST TREASURED CONSTITUENTS. AFTER I WAS 

13 ELECTED TO THE LOS ANGELES CITY COUNCIL, SHE WAS RECRUITED AS 

14 THE COMMUNITY VOLUNTEER BY MY FORMER SENIOR DEPUTY, ROSEMARY 

15 LOPEZ. MISS PINNEY SERVED AS CAPTAIN OF ONE OF OUR M.A.S.H. 

16 UNITS, "MORE ADVOCATES FOR SAFE HOMES." SHE WAS A KEY LEADER 

17 ON BEHALF OF THE NEIGHBORS AND AN ARRAY OF COMMUNITY ISSUES. 

18 SHE WAS ENERGETIC AND AN ACTIVE COMMUNITY VOLUNTEER, WHO 

19 TIRELESSLY DEVOTED HER TIME ON BEHALF OF HER NEIGHBORHOOD. SHE 

20 WORKED CLOSELY WITH MY STAFF AS WELL AS WITH THE COUNTY 

21 DEPARTMENTS TO ELIMINATE CRIME AND KEEP HER NEIGHBORHOOD SAFE 

22 AND CLEAN. SHE WAS A REMARKABLE COMMUNITY ADVOCATE WHO 

23 REMAINED ACTIVE UNTIL THE FINAL MONTHS OF HER ILLNESS. WE 

24 EXTEND OUR DEEPEST CONDOLENCES TO HER FAMILY. I ALSO WITH TO 

25 ADJOURN IN THE MEMORY OF LONGSTANDING HIGHLAND PARK RESIDENT, 
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1 AMELIA ALVARADO. AMELIA WAS THE BELOVED WIFE OF RAFAEL 

2 ALVARADO WHO HAS SERVED AS A DEVOTED COMMUNITY ADVOCATE FOR 

3 MANY YEARS. WE WANT TO EXTEND OUR THOUGHTS AND PRAYERS TO THE 

4 ALVARADO FAMILY. THOSE ARE MY ADJOURNMENTS. 

5

6 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH, SUPERVISOR. 

7 MEMBERS, I'D LIKE TO READ IN THE FOLLOWING MOTION FOR 

8 CONSIDERATION AT OUR NEXT MEETING. "RECENT REPORTS ISSUED BY 

9 THE U.S. DEPARTMENT OF LABOR INDICATE THAT THE UNEMPLOYMENT 

10 RATE ENDURED BY YOUNGER VETERANS WHO SERVED THEIR COUNTRY 

11 AFTER SEPTEMBER 11, 2001 CONTINUES TO DISPLAY THE LABOR MARKET 

12 VOLATILITY IMPACTING JOB SEEKERS FROM OTHER BACKGROUNDS. 

13 RECENT REPORTS ALSO SUGGEST VETERANS CONTINUE TO SUFFER HIGHER 

14 YEAR-END UNEMPLOYMENT FOR YOUNGER POST-9/11 VETERANS. THE 

15 VETERAN GROUP BETWEEN THE AGES OF 18 AND 24 CONTINUES TO POST 

16 A MUCH HIGHER UNEMPLOYMENT RATE, APPROXIMATING 20 PERCENT. 

17 THIS RATE OF UNEMPLOYMENT IS EXPECTED TO INCREASE 

18 SUBSTANTIALLY AS U.S. TROOPS STATIONED IN AFGHANISTAN EXIT BY 

19 THE YEAR 2014. THE PRIVATE SECTOR AT THE NATIONAL LEVEL HAS 

20 RESPONDED TO THE CHALLENGES FACED BY POST 9/11 VETERANS BUY 

21 WORKING AGGRESSIVELY TO HIRE AND TRAIN FORMER SERVICE MEMBERS 

22 FOR LONG-TERM SUCCESS, PARTICULARLY IN AREAS OF THE COUNTY 

23 THAT ARE SHOWING THE GREATEST RATE OF HIRING, SPECIFICALLY 

24 CONSTRUCTION, TRADE, TRANSPORTATION AND WAREHOUSING. I 

25 THEREFORE MOVE THAT THE BOARD OF SUPERVISORS DIRECT THE CHIEF 
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1 EXECUTIVE OFFICER, IN CONSULTATION WITH THE DEPARTMENT OF 

2 MILITARY AND VETERAN AFFAIRS AND THE COUNTY WORKFORCE 

3 INVESTMENT BOARD TO REPORT BACK IN TWO WEEKS ON THE 

4 UNEMPLOYMENT RATE CONFRONTING VETERANS IN L.A. COUNTY." IF 

5 THERE'S NO OBJECTION TO THAT MOTION, I SUSPECT THAT THE C.E.O. 

6 CAN COLLABORATE WITH THOSE NAMED IN THE MOTION AND PROVIDE US 

7 WITH THAT INFORMATION IN THAT PERIOD OF TIME. ARE THERE ANY 

8 OBJECTIONS? 

9

10 SACHI HAMAI, EXEC. OFFICER: MR. CHAIRMAN, DID YOU WANT THIS, 

11 SINCE THIS IS A REPORT BACK, DO YOU WANT IT ON NEXT WEEK'S 

12 AGENDA? 

13

14 SUP. RIDLEY-THOMAS, CHAIRMAN: IT DOESN'T NECESSARILY HAVE TO 

15 BE IF THERE'S NO OBJECTION TO GETTING THIS INFORMATION, THEN 

16 THE INSTRUCTIONS WILL BE SO COMMUNICATED PURSUANT TO A 

17 UNANIMOUS VOTE. THANK YOU. ARE THERE ANY OTHER ITEMS TO COME 

18 BEFORE US AT THIS POINT IN TIME? 

19

20 SACHI HAMAI, EXEC. OFFICER: NO. 

21

22 SUP. ANTONOVICH: MR. CHAIRMAN, COULD WE ASK FOR A REPORT BACK 

23 IN TWO OR THREE WEEKS, I BELIEVE THE ATTENDANCE AT OUR COUNTY 

24 FAIR WAS DOWN THIS YEAR, AND I KNOW THE PRICES WERE, 

25 CONSTITUENTS SAY HOW COSTLY MANY OF THE TICKETS AND THE VENUES 



November 5, 2013

59

1 ARE. IF WE COULD HAVE THEM COMPARE THE PRICES THAT ORANGE 

2 COUNTY, VENTURA COUNTY, OUR NEIGHBORING COUNTY FAIRS ARE TO 

3 THE PRICE RANGE, PERHAPS THAT WAS A REASON FOR THAT? OR THERE 

4 MAY HAVE BEEN OTHER REASONS. COULD WE HAVE A REPORT BACK? AS 

5 WE BEGIN PLANNING TO ARE NEXT YEAR'S FAIR. 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU, 

8 SUPERVISOR. IT'S ONE OF THOSE VENUES WHERE THERE COULD 

9 POTENTIALLY BE ENROLLMENT FOR HEALTH REFORM OPPORTUNITIES, 

10 SUPERVISOR. THANK YOU SO MUCH. 

11

12 SUP. ANTONOVICH: DO YOU WANT TO DO THE HEALTH REFORM? WE HAVE 

13 [HOLDING UP NEWSPAPER] "101 SCHOOL DISTRICTS CUT STAFFING 

14 HOURS DUE TO THE HEALTHCARE REFORM." THAT WAS ON THE FRONT 

15 PAGE. BUT I DIDN'T WANT TO BRING THAT UP. 

16

17 SUP. RIDLEY-THOMAS, CHAIRMAN: I UNDERSTAND THAT. FRONT PAGE OF 

18 THE ANTONOVICH EXPRESS, WE UNDERSTAND THE PUBLISHING BUSINESS 

19 NOW. [LAUGHTER.] ALL RIGHT. ANY OTHER READ-INS OR REQUESTS? 

20 SEEING NONE, WE'LL PROCEED TO PUBLIC COMMENT. OSCAR JOHNSON, 

21 ALEXANDRA LEE, JONATHAN NOWAK, LORI MARTIN, IRENE PANG, ERIC 

22 PREVEN, BOBBY COOPER, AND ALISA MALLORGA, AND MORRIS GRIFFIN, 

23 IN THAT ORDER, PLEASE, IF YOU WOULD COME FORWARD. MR. JOHNSON, 

24 THE FLOOR IS YOURS. YOU MAY PROCEED. 

25
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1 OSCAR JOHNSON: YES, MY NAME IS OSCAR. I SPEAK FOR THE 

2 OPPRESSED. I SPEAK FOR THE STRUGGLING POOR AND I SPEAK FOR 

3 CULTURE CHANGE. I'D LIKE TO SPEAK ABOUT SOCIETY. AMERICA MUST 

4 FALL. MODERN BABYLON MUST FALL. WE'RE LIVING IN THE ECONOMIC 

5 COLLAPSE OF THE WORLD TODAY. THE WORLD AND AMERICA MUST FALL 

6 AND AMERICA MUST COME BACK UP STRAIGHT, BE REBIRTHED. WE HAVE 

7 INVITED TOO MANY PEOPLE FROM UNDEVELOPED COUNTRIES TO TRY TO 

8 PUT WEIGHT ON THEM IN AMERICA, AND WE KNOW THEY CANNOT CARRY. 

9 IT'S VERY EMBARRASSING TO SEE HOW MANY PEOPLE FROM DIFFERENT 

10 PARTS OF THE WORLD TRYING TO EXIST IN THIS WHAT WE CALL LOS 

11 ANGELES, CALIFORNIA. BUT I SEE MANY NATIONS, MANY CITIES IN 

12 AMERICA HAVE CRUMBLED. HUNDREDS HAVE BEEN HOUSED IN MANY 

13 CITIES. I THINK LOS ANGELES WOULD BE CRUMBLING IF IT WEREN'T 

14 FOR THE HISPANIC PEOPLE HERE IN LOS ANGELES. AND THIS IS NOT 

15 AMERICA. BUT SOME TYPE OF WAY WE'VE BEEN MISEDUCATED, 

16 UNEDUCATED, MISLED AND MISGUIDED IN AMERICA. WE NEED 

17 ACCOUNTABILITY AMONGST OUR LEADERS TODAY IN AMERICA. I FEEL SO 

18 EMBARRASSED. I THOUGHT WE SUPPOSED TO HAVE AN AIM AND A 

19 PURPOSE IN AMERICA. BUT MANY TIMES PEOPLE FROM DIFFERENT 

20 PLACES FIND ME AND WATCHES ME. I LOOKS AT THE POLICE 

21 DEPARTMENT HOW THEIR NUMBERS STAY IN MY PATHS MANY TIMES. AND 

22 WE HAVE MANY PEOPLES DOWN ON SKID ROW EATING THEIR FOOD AT THE 

23 MISSION. THEY GET INJURED WITH EATING IT AND EVEN DYING FROM 

24 IT, THOUGH. DYING EATING THAT FOOD BECAUSE THEY HAD A 

25 SALMONELLA SCARE WITH THE FARMER JOHN CHICKEN ABOUT THREE OR 
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1 FOUR MONTHS AGO, HOW MANY HUNDREDS OF PEOPLE WERE EATING 

2 FARMER JOHN FOOD WERE GETTING INJURED FOR IT, THOUGH. SO WE 

3 SHOULD TRY TO CLEAN UP AMERICA FIRST BEFORE WE GO TO OTHER 

4 COUNTRIES AND CARRYING OUR GERMS AND OUR DESTRUCTION IN THEY 

5 LAND. 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. 

8 SIR, YOUR NAME? 

9

10 JONATHAN NOWAK: MY NAME IS JONATHAN NOWAK AND I'M HERE TODAY 

11 TO TALK ABOUT ADULT ATTENTION DEFICIT HYPERACTIVITY DISORDER 

12 OR A.D.H.D. 

13

14 SUP. RIDLEY-THOMAS, CHAIRMAN: SIR? 

15

16 JONATHAN NOWAK: I'VE DISCOVERED THAT ALL COUNTY CLINICS, WHICH 

17 IS WHERE MOST OF THE PEOPLE WHO CANNOT AFFORD HEALTH CARE AND 

18 CANNOT AFFORD TO GO TO A PROFESSIONAL PSYCHOLOGIST CAN GO TO 

19 THERE, BUT THEY ARE NOT TREATING THAT. I FOUND OUT IT IS A 

20 POLICY OF THE COUNTY OF LOS ANGELES THAT THEY ARE NOT ALLOWED 

21 TO TREAT OR PRESCRIBE MEDICATIONS FOR A.D.H.D., WHICH I THINK 

22 IS VERY STRANGE CONSIDERING THAT IT IS A VERY SERIOUS MENTAL 

23 DISORDER. IT'S BASED ON AN IMBALANCE OF NEUROTRANSMITTERS IN 

24 THE BRAIN. JUST LIKE SOMEBODY WITH DEPRESSION HAS A SHORTAGE 

25 OF NEUROTRANSMITTERS, THEY GET A PILL THAT HELPS BALANCE THAT. 
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1 SOMEBODY WHO IS SCHIZOPHRENIC, THEY HAVE AN IMBALANCE. 

2 MEDICATION HELPS THAT. BUT A.D.H.D. IS THE SAME THING, IT IS A 

3 SERIOUS CONDITION WHICH IS AN IMBALANCE OF NEUROTRANSMITTERS 

4 AND THERE ARE MEDICATIONS THAT ARE PROVEN TO HELP THAT. IT'S 

5 KNOW THE JUST A CHILDHOOD DISORDER. IT CONTINUES INTO 

6 ADULTHOOD. AND ESPECIALLY FOR THOSE WHO ARE UNEMPLOYED, THE 

7 DISORDER IS REALLY KEEPING THEM FROM GETTING THE EMPLOYMENT 

8 THAT THEY NEED. ALL THOSE LIFE ACTIVITIES THAT IT IMPAIRS. 

9 IT'S A SERIOUS IMPAIRMENT OF LIFE ACTIVITIES. IT'S SERIOUS 

10 ENOUGH THAT IS COVERED AND PROTECTED BY THE AMERICANS WITH 

11 DISABILITIES ACT. THERE SHOULD BE NO REASON WHY THEY SHOULD 

12 NOT BE ABLE TO GET THE CARE THAT THEY SO NEED AT A COUNTY 

13 CLINIC, ESPECIALLY SINCE THEY CAN GET THAT AT A PROFESSIONAL-- 

14 AT A PRIVATE PRACTICE, BUT THEY CANNOT AFFORD THAT IF THEY ARE 

15 UNEMPLOYED. SO I WOULD LIKE TO SEE IF WE COULD GET SOMETHING 

16 ON AN AGENDA OR IF MAYBE-- THIS IS A LOT MORE THAN I CAN 

17 DISCUSS IN TWO MINUTES BUT WOULD LIKE TO SEE IF THERE'S A 

18 PLACE WHERE I CAN DISCUSS THIS FURTHER. I CAN GET SOME 

19 DOCUMENTATION AND INFORMATION TO BACK UP THIS INFORMATION. AND 

20 I'D LIKE TO SEE THIS GET ON THE AGENDA SO SOMETHING CAN BE 

21 DONE ABOUT THIS AND SOMETHING COULD BE DONE SOON. 

22

23 SUP. RIDLEY-THOMAS, CHAIRMAN: WE THANK YOU FOR YOUR TESTIMONY. 

24 ONE OF MY STAFF MEMBERS WILL TALK WITH YOU PRETTY IMMEDIATE 

25 ABOUT THAT IF YOU WANT TO. SHARE WITH HIM THE INFORMATION THAT 



November 5, 2013

63

1 YOU HAVE. WE WILL FIND A WAY TO GET TO THE BOTTOM OF THE 

2 ASSERTIONS THAT YOU MAKE AND KEEP YOU IN THE LOOP WITH THAT 

3 MORE DIRECTLY WITH THE DEPARTMENT OF HEALTH SERVICES AND/OR 

4 THE DESIGNATED DEPARTMENT. IT COULD BE MENTAL HEALTH SERVICES, 

5 AS WELL, ALL RIGHT? 

6

7 JONATHAN NOWAK: THANK YOU VERY MUCH. 

8

9 SUP. RIDLEY-THOMAS, CHAIRMAN: COUNT ON IT. THANKS. MISS 

10 AUSTRIA IS RIGHT THERE. ALL RIGHT. NEXT SPEAKER. MA'AM? 

11

12 ALEXANDRA LEE: HI, I'M ALEXANDRA LEE. I'M HERE TODAY BECAUSE I 

13 STAND FALSELY ACCUSED OF BEING A CHILD ABUSER. THROUGH NO 

14 FAULT OF MY OWN, I FIND MYSELF ON THE CHILD ABUSE INDEX. I 

15 HAVE NEVER GOTTEN A FAIR GRIEVANCE TO START WITH AND MY CASE 

16 NEVER OPENED UP IN D.C.F.S. THIS HEARING WAS CONDUCTED BY 

17 SOMEONE WHO DOESN'T PRACTICE LAW AND IS IN THE PAY OF D.C.F.S. 

18 EVEN THOUGH THE SOCIAL WORKER ADMITTED SHE LIED IN THE 

19 MEDIATION, MISS ALINA TOSTADO, THE MEDIATOR SAID I NEEDED TO 

20 ACCEPT THIS AND MOVE ON. I ASK YOU HERE TODAY WHY I SHOULD 

21 ACCEPT SUCH BEHAVIOR FROM PROFESSIONALS FROM D.C.F.S.? THE 

22 MEDIATOR THEN WROTE HER FINAL REPORT TO AGREE WITH AND 

23 COINCIDE WITH THE SOCIAL WORKER'S ERRONEOUS REPORT, LEAVING 

24 ALL TAINTED WITH TONES OF COLLUSION. THIS IS NOT PROFESSIONAL 

25 AT ALL. IN ADDITION, A VOICE RECORDING LEFT BY THE MEDIATOR ON 
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1 MY ANSWERING MACHINE ATTESTS TO MY FAILURE TO GET PROPER DUE 

2 PROCESS. WHEN I GOT IN TOUCH WITH MR. FRANCIS CHUBAN [PH?] 

3 THROUGH THE KIND OFFICES OF MISS GRACE YU, A PRESIDENT OF THE 

4 KOREAN COALITION GROUP, HE EMAILED ME TO SAY THAT HE WOULD 

5 OVERSEE MY CASE AND ENSURE THAT IT GOT HANDLED PROPERLY. 

6 UNFORTUNATELY HE LEFT THE DISTRICT BEFORE HE COULD DO SO. I 

7 THEN CONTACTED MARIA ROMERA, BUT SHE HAD NO IDEA WHAT A 

8 C.A.C.I. GRIEVANCE HEARING WAS. I CALLED HER AGAIN TO ASK IF 

9 SHE WOULD CONTACT BRANDON NICHOLS, SENIOR DEPUTY AT D.C.F.S. 

10 ON MY BEHALF AS MR. CHUBAN HAD DONE. I MENTIONED THE CASE OF 

11 RON GONZALES VERSUS SANTA CLARA COUNTY DEPARTMENT OF SOCIAL 

12 SERVICES WHERE THE JUDGE REVERSED JUDGMENT. SHE TOOK THE LINE 

13 OF RESISTANCE BY ADVISING ME TO ADDRESS MY CONCERNS WITH ALDO 

14 MOREIN. I ASKED HER FOR HER SUPERIOR. MISS ROLANDA LUNA GOT ON 

15 THE PHONE AND PRETENDED TO BE MISS ROMERO'S BOSS. SHE ASKED 

16 FOR MY ADDRESS WHICH I THOUGHT WAS STRANGE AND SHE PROMISED TO 

17 DO EVERYTHING TO HELP ME. IT SOUNDED LIKE A BRUSHOFF. WHEN I 

18 LOOKED INTO THE DIRECTORY, IT TURNS OUT SHE IS AN 

19 ADMINISTRATIVE ASSISTANT. WHEN I CALLED BACK TO ASK HER WHY 

20 SHE PRETENDED TO BE MISS RAMON'S BOSS, SHE STARTED TO YELL AT 

21 ME AND HUNG UP. I CALLED MISS ROMERO WHO ANSWERED THE PHONE 

22 HERSELF AND SHE THEN HUNG UP AFTER SAYING SHE COULD NOT HELP. 

23 I THEN EMAILED MISS ALMA MARTINEZ AND THIS IS HER RESPONSE. 

24 "MISS LEE, I LOOKED AT OUR EXTENSIVE FILE ON YOUR CONTACTS 

25 WITH OUR OFFICE AND DETERMINED THAT WE HAVE BEEN ABUNDANTLY 
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1 CLEAR THAT YOU ARE TO CALL ALDO MOREIN. PLEASE BE AWARE THAT 

2 THIS WILL CONTINUE TO BE OUR RESPONSE, NO MATTER WHO YOU 

3 CONTACT IN THIS OFFICE. 

4

5 SUP. RIDLEY-THOMAS, CHAIRMAN: MA'AM? 

6

7 ALEXANDRA LEE: THIS IS WHY I'M HERE. IT IS LOGICAL THAT THE 

8 GOVERNMENTAL AGENCY THAT OVERSEES D.C.F.S.-- 

9

10 SUP. RIDLEY-THOMAS, CHAIRMAN: YOUR TIME HAS EXPIRED. I WOULD 

11 BE GLAD TO HAVE YOU TRANSMIT THAT TO THE SERGEANT WHO CAN 

12 SHARE IT WITH THE ENTIRE BOARD IF YOU LIKE. IF THERE'S A 

13 SPECIFIC REQUEST THAT YOU ARE MAKING, WE WILL SEEK TO 

14 ACCOMMODATE IT. IF THERE'S SOMEONE WHO YOU WISH TO SEE AT THIS 

15 POINT IN TIME? WHAT IS YOUR PLEASURE? 

16

17 ALEXANDRA LEE: BUT I'M ASKING YOU GUYS FOR SOME HELP. 

18

19 SUP. RIDLEY-THOMAS, CHAIRMAN: RIGHT. 

20

21 ALEXANDRA LEE: YEAH. 

22

23 SUP. RIDLEY-THOMAS, CHAIRMAN: SO WHERE DO YOU RESIDE? 

24

25 ALEXANDRA LEE: I'M SORRY. 
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1

2 SUP. RIDLEY-THOMAS, CHAIRMAN: WHERE DO YOU RESIDE? 

3

4 ALEXANDRA LEE: I CAN'T HEAR. 

5

6 SUP. YAROSLAVSKY: WHERE DO YOU LIVE? 

7

8 ALEXANDRA LEE: OH, WHERE DO I RESIDE? I LIVE IN DOWNTOWN L.A. 

9

10 SUP. RIDLEY-THOMAS, CHAIRMAN: OKAY. THEN WE'RE GOING TO ASK 

11 SOMEONE FROM THE DEPARTMENT, THEY CAN COME AND HAVE A 

12 SPECIFIC-- 

13

14 ALEXANDRA LEE: I'VE ASKED GLORIA MOLINA'S OFFICE TO HELP ME, 

15 AND NO ONE IS THERE TO HELP ME ANYMORE. 

16

17 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. IF YOU WOULD HAVE A 

18 SEAT RIGHT THERE, WE'LL HAVE SOMEONE FROM THE DEPARTMENT TO 

19 HELP YOU. AND IF YOU WANT TO SHARE THOSE DOCUMENTS WITH OTHER 

20 MEMBERS, YOU MAY DO SO. 

21

22 ALEXANDRA LEE: OKAY, GREAT. THANK YOU SO MUCH. 

23

24 SUP. RIDLEY-THOMAS, CHAIRMAN: YOU'RE VERY WELCOME. ALL RIGHT. 

25 THANK YOU. ALL RIGHT. LORI MARTIN. 
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1

2 ERIC PREVEN: ARE WE IN THAT ORDER? IT'S NOT MR. PREVEN? OKAY, 

3 FINE. GO AHEAD, LORI. 

4

5 LORI MARTIN: GOOD MORNING. MORE SO THAN A PUBLIC COMMENT, I 

6 ACTUALLY HAVE A QUESTION AS TO THIS NEW VENDOR THAT YOU'LL BE 

7 CONTRACTING FOR EMPLOYMENT OR EMPLOYMENT SERVICES? I CAN ONLY 

8 SAY IN HOPES, IS THAT BECAUSE S.E.I.U. IS GOING TO BE DONE 

9 WITH? I SURE HOPE SO. I SENT EACH AND EVERY ONE OF YOUR 

10 OFFICES A VERY, VERY DISTURBING PIECE OF FOOTAGE WHERE THESE 

11 S.E.I.U. WORKERS WERE HITTING MY FRIEND OVER THE HEAD WITH 

12 THEIR PROTEST SIGNS AND BASICALLY SURROUNDING HER, LIKE A 

13 GANG, SO SHE COULDN'T PUT HER FIRST AMENDMENT RIGHT OUT THERE. 

14 WOW. THIS IS WHAT'S REPRESENTING D.C.F.S.? THIS IS WHAT YOUR 

15 COUNTY HAS DEALING WITH FAMILIES AND CHILDREN? ONE LITTLE LONE 

16 LADY AGAINST THE THOUSAND, THE SEA OF THOUSANDS OF WORKERS AND 

17 THEY SURROUND HER, TORE HER SIGN OUT OF HER HANDS AND TORE IT 

18 UP. THAT IS AMAZING. THAT IS TRULY AMAZING. I AM SO 

19 EMBARRASSED THAT I HAVE TO COME UP HERE AND SPEAK ABOUT IT FOR 

20 MY FRIEND, BUT I KNOW HER AND HER TACTFULNESS AND HER PRIDE 

21 WOULD STOP HER FROM DOING SO. SO I HAVE TO ASK, ARE WE DONE 

22 WITH S.E.I.U.? MR. FUJIOKA? ARE WE DONE WITH THIS UNION? 

23

24 SUP. RIDLEY-THOMAS, CHAIRMAN: FOR THOSE WHO ARE IN THE 

25 AUDIENCE, THEY ARE NOT OBLIGED TO RESPOND. THE QUESTION CAN BE 



November 5, 2013

68

1 POSED. YOU HAVE POSED IT, MS. MARTIN. ARE THERE ANY OTHER 

2 REMARKS YOU WISH TO MAKE AT THIS TIME? 

3

4 LORI MARTIN: NO, I JUST HOPE THAT THE CLARITY IS THERE, YOU 

5 KNOW. WE'VE CAUGHT IT ON VIDEO FOOTAGE, PHYSICAL ASSAULT ON 

6 PUBLIC MEMBERS. WHAT ARE THEY DOING BEHIND CLOSED DOORS TO 

7 FAMILY AND CHILDREN? THANK YOU. 

8

9 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU. ALL RIGHT. IRENE 

10 PANG. 

11

12 IRENE PANG: GOOD MORNING, EVERYONE. MY NAME'S IRENE. I 

13 CONCERNED ABOUT THE CASE WITH NATURE, THE TOWER SYSTEM, THE 

14 TOWER INFORMATION SYSTEM PROTECTION. DURING I WAS ON DUTY, MY 

15 CAR AND MY DRIVER'S LICENSE ARE IMPOUND BY EL MONTE POLICEMAN 

16 WHO HAD BEEN BEING LAWSUIT BY THERE, THE ONE _____ AND FAILED 

17 TO SUPPORT GOVERNMENT INFORMATION SYSTEM PROTECTION. AFTER I 

18 PULL MY CAR FASTENING DURING I AM ON DUTY. IMPOUND MY CAR AND 

19 LOCKED ____ WHEN HE SAY IRENE'S CAR IS PART OF THE PROTECTION 

20 OVER THE TOWER INFORMATION SYSTEM, INFORMATION SYSTEM. THAT IS 

21 SHOWING THAT SOME CAR IS THERE HIDING THE PURPOSE DURING 

22 THOSE, THE ____. I NOW STILL NEED MY CAR BACK. AND OTHERWISE 

23 SINCE THEY IMPOUND MY CAR FROM THE FEBRUARY 12 TO NOW, I NEED 

24 MY CAR BACK AND ALSO NEED MY-- ALL THE PERSONAL BELONGINGS, 

25 INCLUDE THE PERSONAL TOOL BELT AND MY PERSONAL I.D.S, AND ALSO 
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1 MY DRIVER'S LICENSE. I NEED THEM ALL BACK. SINCE MY CASE 

2 THEY'VE BEEN SUED AND I NEED ALL THE VICTIM HAVE BEEN SUFFERED 

3 FROM THOSE THERE IN COLD WEATHER DURING THE WORKING LOW CAR. 

4 NOW THE COLD WEATHER COMING AGAIN. THAT'S WHY I NEED MY CAR 

5 BACK AND ALL THE BELONGINGS, TOO. AND THEN SECOND, I BELIEVE 

6 THAT MY FAMILY MEMBERS HAD WHY TO WORK HARD TO HELP _____ 

7 BUILD UP TO THIS COUNTRY. 

8

9 SUP. RIDLEY-THOMAS, CHAIRMAN: MRS. PANG? 

10

11 IRENE PANG: BUT I BELIEVE THAT MY FAMILY MEMBERS NEED THE 

12 POSITION AND SUPPORT, TO COME AND SUPPORT. 

13

14 SUP. RIDLEY-THOMAS, CHAIRMAN: MISS PANG? 

15

16 IRENE PANG: NOT THOSE, THEY'RE THREATENING-- 

17

18 SUP. RIDLEY-THOMAS, CHAIRMAN: HELLO? 

19

20 IRENE PANG: --TO THEIR CHILDREN EVERY NIGHT OF THE DAY, 

21 YELLING-- 

22

23 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU FOR YOUR TESTIMONY. 

24 YOUR TIME HAS EXPIRED, MISS PANG. OKAY? 

25
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1 IRENE PANG: THANK YOU. 

2

3 SUP. RIDLEY-THOMAS, CHAIRMAN: THANK YOU VERY MUCH. ALL RIGHT. 

4

5 ERIC PREVEN: NOW IT'S TIME FOR MR. PREVEN, I BELIEVE, NO? 

6

7 SUP. RIDLEY-THOMAS, CHAIRMAN: I CALLED ERIC PREVEN, BOBBY 

8 COOPER, ALISA MALLORGA, MORRIS GRIFFIN IN THAT ORDER. IF YOU 

9 WOULD COME FORWARD AND CONCLUDE. MR. PREVEN, THE FLOOR IS 

10 YOURS, SIR. 

11

12 ERIC PREVEN: THANK YOU, SUPERVISOR. IT'S ERIC PREVEN, THE 

13 COUNTY RESIDENT FROM DISTRICT 3. YOU KNOW, THE ITEM NO. 10, 

14 WHICH HAS BEEN PUSHED BACK, IS THE CHAIR AND GLORIA MOLINA 

15 HAVE COME UP WITH A CIVILIAN COMMISSION ON THE SHERIFF'S 

16 OFFICE, POSSIBLY. AND I GUESS I WOULD AIM THESE AT SUPERVISOR 

17 YAROSLAVSKY BECAUSE I THINK HE'S THE MOST LIKELY TO GET ON 

18 BOARD WITH THIS, BUT HE DOESN'T SEEM TO BE HERE RIGHT NOW. 

19 THAT'S AWKWARD. OH THERE HE IS. SIR, I DO THINK THAT THERE'S 

20 SOME CLAMORING FROM THE PUBLIC FOR OVERSIGHT OF THE PROBLEMS 

21 IN OUR JAILS AND ALSO IN OUR DEPARTMENT OF CHILDREN AND FAMILY 

22 SERVICES. I THINK THE FEELING IS THAT ORDINARY RESIDENTS MIGHT 

23 HAVE SOMETHING TO OFFER TO THE PROCESS OF SCRUTINIZING WHAT'S 

24 GOING ON THERE. THIS BOARD, AS WE'VE HEARD NUMEROUS TIMES, 

25 MIRED IN LOTS OF DIFFERENT DETAILS AND, THUS, DEPLOYING 
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1 MOTIVATED BUT ORDINARY RESIDENTS WOULD BE A VERY GOOD CHOICE. 

2 AND I WOULD ASK YOU TO CONSIDER THAT. I KNOW YOU'VE BEEN 

3 CONCERNED THAT THERE'S ENOUGH BEING DONE. THERE'S NOT, I 

4 THINK. AND I THINK IT'S TIME TO TAKE THAT VERY SERIOUSLY. 

5 THERE'S A COUPLE OF CLOSED SESSION ITEMS LAST WEEK THERE WAS 

6 NO REPORTABLE ACTION ON CS-3, WHICH WAS A TYLER WILLIS VERSUS 

7 THE COUNTY OF LOS ANGELES. THIS IS ONE WHERE THE SHERIFF IS 

8 ASKED TO PAY $100,000 IN DAMAGE. A JURY CAME BACK WITH THAT. I 

9 WOULD ASK THIS BOARD TO THINK LONG AND HARD BEFORE THEY AGREE 

10 TO APPEAL ON HIS BEHALF BECAUSE I THINK THAT WE'VE SEEN THAT 

11 THERE HAS BEEN SOME NEGLIGENCE TIED TO THE C.C.J.V. AND THAT 

12 GLORIA MOLINA CERTAINLY BELIEVES IN PUNISHMENT, WE'VE HEARD 

13 HER SAY NUMEROUS TIMES. I THINK WE SHOULD APPLY THAT STANDARD 

14 IF WE ARE DOING IT ACROSS ALL CATEGORIES, INCLUDING THE 

15 SHERIFF. I JUST WANT TO CIRCLE BACK TO 32, WHICH IS THE JOB 

16 ORDER CONTRACTING. SOMETHING SMELLS BAD ABOUT THIS. I JUST 

17 BROKE IT DOWN. THE ITEM, I CAN'T TELL WHICH OF THE EIGHT JOB 

18 ORDER CONTRACTS ARE FOR THE ELECTRONIC HEALTHCARE RECORD WORK. 

19 THEY'RE NOT SPECIFIED BY WHICH JOB. AND, THUS, IT'S HARD TO 

20 UNDERSTAND WHICH OF THE CONTRACTORS IS GETTING THE HIGH NUMBER 

21 OF J.O.C.S. I KNOW THAT ACE HAS GOT FIVE. MCCONE GOT FOUR. 

22 ____ GOT ONE. M.T.M. GOT ONE.  

23

24 SUP. RIDLEY-THOMAS, CHAIRMAN: AND WE THANK YOU-- 

25
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1 ERIC PREVEN: AND ____ GOT THROUGH THREE. BUT THESE ARE ALL 

2 $4.3 MILLION. SO HOW MANY HAVE THEY HAD IN THE PAST? THERE 

3 SEEMS TO BE A VERY TIGHT- KNIT GROUP OF COMPANIES THAT KEEP 

4 WINNING THESE AWARDS. 

5

6 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. WE THANK YOU FOR YOUR 

7 TESTIMONY. 

8

9 ERIC PREVEN: YOU'RE WELCOME, SIR. 

10

11 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. WE'LL MOVE TO THE 

12 NEXT SPEAKER, PLEASE. SIR, MA'AM? 

13

14 ALISA MALLORGA (VIA INTERPRETER): GOOD MORNING, MY NAME IS 

15 ALISA MALLORGA. I WORKED FOR 28 YEARS AT VISTA DEL SOL 

16 HEALTHCARE SERVICES WITH HANDICAPPED PEOPLE. I WORKED 28 YEARS 

17 WITH VISTA DEL SOL AND I WAS TERMINATED. AND SINCE MY 

18 TERMINATION, THERE HAVE BEEN CHAOS GOING ON AT THE CLINIC WITH 

19 ALL THE HANDICAPPED PATIENTS. OKAY, SINCE AGAIN MY 

20 TERMINATION, THE WORK AT THE CLINIC IS DIFFERENT. IT'S NOT THE 

21 SAME. THE MAINTENANCE OF CLEANING IS NOT DONE PROPERLY. THE 

22 PATIENTS ARE FEELING VERY UNCOMFORTABLE. AND THE SUPERVISOR 

23 FOR THE FACILITY, HER NAME IS ROSA BALDIVIA, DOESN'T REALLY 

24 CARE ABOUT THE PATIENTS FOR THEIR GOOD CARING. I WANT JUSTICE 

25 FOR ME AS A WORKER AND ALSO FOR THE PATIENTS OF THE FACILITY. 
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1 I WILL PROVIDE THE INFORMATION. SHE IS REQUESTING IF IT'S 

2 POSSIBLE FOR SOMEONE TO CALL THE OWNER OF THE FACILITY WHOSE 

3 NAME IS MARIAN FORSYTHE. THE PRESIDENT OF THE COMPANY IS JAMES 

4 PRINSBURGER. AND ALSO THE PHONE NUMBER IS PROVIDED 213-220-

5 4808. SO THEY COULD DO SOMETHING ABOUT IT AND TAKE CARE OF 

6 THAT, THIS PROBLEM. 

7

8 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. WE THANK YOU FOR 

9 YOUR-- SUPERVISOR MOLINA, PLEASE? 

10

11 SUP. MOLINA: (IN SPANISH). I WAS TELLING HER THAT THIS IS A 

12 STATE-RELATED ISSUE THAT SHE SHOULD CALL HER ASSEMBLY PERSON 

13 OR A STATE SENATOR, THAT IT'S STATE RELATED, THAT WE CAN'T DO 

14 ANYTHING. WE MIGHT BE ABLE TO MAKE A PHONE CALL BUT IT 

15 WOULDN'T MEAN ANYTHING. 

16

17 SUP. RIDLEY-THOMAS, CHAIRMAN: YES. WE TAKE NOTE OF THE FACT 

18 THAT SHE'S A RESIDENT OF INGLEWOOD, THEREFORE WE WILL CONNECT 

19 YOU WITH THE APPROPRIATE OFFICIAL SO THAT YOU CAN FOLLOW UP 

20 ACCORDINGLY, ALL RIGHT? 

21

22 ALISA MALLORGA: THANK YOU. GRACIAS. 

23



November 5, 2013

74

1 SUP. RIDLEY-THOMAS, CHAIRMAN: YES, ALL RIGHT. KATHLEEN, IF YOU 

2 CAN BE HELPFUL TO HER, WE'D APPRECIATE IT VERY MUCH. FINAL 

3 SPEAKER, PLEASE. 

4

5 MORRIS GRIFFIN: TO THE CHAIR, MEMBERS OF THE BOARD, I'M HERE 

6 TODAY TO ADDRESS ITEM NO. A-2. SHERIFF, I WOULD APPRECIATE IT 

7 IF YOU WOULD LET THE SUPERVISORS HOLD IN THEIR HAND THIS 

8 DEADLY WEAPON. I BROUGHT THIS PARTICULAR FLASHLIGHT TO SHOW 

9 AND ASK AFTER 2-1/2 YEARS, WE KNOW THAT OUR JAIL HAD A 

10 COMPLAINT WHERE SOMEONE WAS MURDERED BY THE FLASHLIGHT. SO I'M 

11 HERE TODAY TO ASK THAT YOU CONSIDER ASKING CHIEF SHERIFF BACA 

12 TO BAN ALL LONG-HANDLED METAL FLASHLIGHTS IN THE PRISONS. NOT 

13 IN THE PUBLIC BUT JUST IN THE PRISONS SO THAT WE DON'T HAVE TO 

14 DEAL WITH ANYMORE LAWSUITS. I HAPPEN TO LIKE SHERIFF BACA. I 

15 BELIEVE THAT THIS WOULD HELP US HELP EACH OTHER IN TERMS OF 

16 PREVENTING MORE LAWSUITS. SO I WOULD ASK THAT YOU CONSIDER 

17 THIS. SO I WOULD ASK THAT YOU HOLD IT IN YOUR HAND AND HIT IT 

18 IN YOUR HAND JUST TO SEE WHAT WE'RE TALKING ABOUT. NOW, 

19 GRANTED, IN COMING IN, I WAS TOLD THAT IT WAS-- GOOD, GOOD, 

20 GOOD. MY SECOND QUESTION, OR MY SECOND ISSUE IS WITH YOU, 

21 EXECUTIVE OFFICER FUJIOKA. ALL OUR LIVES WE'VE BEEN TOLD AND 

22 TALKED TO ABOUT NOT LYING. AND OUR NEWSPAPERS HAVE TOLD US 

23 THAT THERE'S $24.7 BILLION IN THE BUDGET, YET YOUR 

24 ADMINISTRATION COMES TO US AND TELLS US THERE IS NO MONEY. 

25 THIS IS AN INSULT TO OUR INTELLIGENCE. AND WE WOULD ASK THAT 
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1 YOU CONSIDER WITH THE $24.7 BILLION PROPOSITION 30 THAT JUST 

2 PASSED IN TERMS OF ADDRESSING OUR MEDICAL. I WOULD ASK THAT 

3 WITH THAT, AND THE $1 BILLION EXTRA THAT WE AS 55,000 COUNTY 

4 EMPLOYEES SAVE THE COUNTY, I WOULD ASK THAT YOU CONSIDER 

5 GIVING US A FAIR BARGAIN HERE. WE'RE ASKING THAT YOU GIVE US 

6 AT LEAST 14 PERCENT. WE'RE ASKING FOR STEPS. WE'RE ASKING FOR 

7 AN OPPORTUNITY TO SHOW THAT WE DESERVE THIS. THIS IS NOTHING 

8 THAT WE'RE BEGGING. WE DESERVE THIS. WE'VE SHOWN-- WE WENT 

9 WITHOUT A CONTRACT FOR FIVE YEARS, SIR. THAT'S ALL OF MY TIME. 

10 THANKS FOR YOURS. HERE'S A COPY OF IT, AS WELL. 

11

12 SUP. RIDLEY-THOMAS, CHAIRMAN: ALL RIGHT. THANK YOU VERY MUCH 

13 FOR YOUR TESTIMONY. THAT CONCLUDES THE LIST OF-- EXHAUSTED THE 

14 LIST OF THOSE WHO WISH TO BE HEARD BY WAY OF PUBLIC COMMENT. 

15 MADAME EXECUTIVE OFFICER, PLEASE? 

16

17 SACHI HAMAI, EXEC. OFFICER: IN ACCORDANCE WITH BROWN ACT 

18 REQUIREMENTS, NOTICE IS HEREBY GIVEN THAT THE BOARD OF 

19 SUPERVISORS WILL CONVENE IN CLOSED SESSION TO DISCUSS ITEM NO. 

20 CS-1, CS-2 AND CS-3, CONFERENCES WITH LEGAL COUNSEL REGARDING 

21 EXISTING LITIGATION. ITEM NO. CS-4, CONFERENCE WITH LABOR 

22 NEGOTIATOR WILLIAM T FUJIOKA, DESIGNATED STAFF AND SEAN ROGAN, 

23 COMMUNITY DEVELOPMENT COMMISSION EXECUTIVE DIRECTOR AND 

24 DESIGNATED STAFF, AND ITEM NO. CS-5, DEPARTMENT HEAD 

25 PERFORMANCE EVALUATIONS AS INDICATED ON THE POSTED AND 
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1 SUPPLEMENTAL AGENDAS. PLEASE BE ADVISED THAT THE NEXT REGULAR 

2 MEETING OF THE BOARD OF SUPERVISORS IS SCHEDULED FOR TUESDAY, 

3 NOVEMBER 12, 2013 AT 1 P.M. THANK YOU. 

4

5

6

7

8
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10
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1 REPORT OF ACTION TAKEN IN CLOSED SESSION NOVEMBER 5, 2013

2

3

4

5 In closed session, item CS-1 was continued one week to 

6 November 12, 2013. 

7

8 CS-2. CONFERENCE WITH LEGAL COUNSEL  EXISITING LITIGATION 

9 (Paragraph (1) of Subdivision (d) of Government Code Section 

10 54956.9) James Bozajian v. County of Los Angeles, et al., U.S. 

11 District Court Case No. CV12-00625. 

12

13 This lawsuit involves allegations of employment discrimination 

14 in the District Attorneys' Office. (13-4805). 

15

16 The Board authorized settlement of the matter entitled James 

17 Bozajian v. County of Los Angeles. The details of the 

18 settlement will be made available once finalized by all 

19 parties. The vote of the Board was unanimous with all 

20 Supervisors being present. 

21

22 CS-3. CONFERENCE WITH LEGAL COUNSEL  EXISTING LITIGATION 

23 (Paragraph (1) of subdivision (d) of Government Code Section 

24 54956.9) Micah Welch, et al. v. County of Los Angeles, Los 

25 Angeles Superior Court Case No. BC 486 066. 
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1 This medical negligence lawsuit arises from treatment received 

2 at the LAC+USC Medical Center. (13-4990) 

3

4 The Board authorized settlement of the matter entitled Micah 

5 Welch, et al. v. County of Los Angeles. The details of the 

6 settlement will be made available once finalized by all 

7 parties. The vote of the Board was unanimous with all 

8 Supervisors being present.  

9

10 No reportable action was taken was taken on items CS-4 or CS-

11 5. 

12

13

14

15

16

17

18

19

20

21

22

23

24
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1 I, JENNIFER A. HINES, Certified Shorthand Reporter Number 

2 6029/RPR/CRR qualified in and for the State of California, do 

3 hereby certify:

4      That the transcripts of proceedings recorded by the Los 

5 Angeles County Board of Supervisors November 5, 2013,

6 were thereafter transcribed into typewriting under my 

7 direction and supervision;

8      That the transcript of recorded proceedings as archived 

9 in the office of the reporter and which have been provided to 

10 the Los Angeles County Board of Supervisors as certified by 

11 me.

12      I further certify that I am neither counsel for, nor 

13 related to any party to the said action; nor

14 in anywise interested in the outcome thereof.

15      IN WITNESS WHEREOF, I have hereunto set my hand this 

16 11th day of November 2013, for the County records to be used 

17 only for authentication purposes of duly certified transcripts      

18 as on file of the office of the reporter.

19   

20                    JENNIFER A. HINES 

21              CSR No. 6029/RPR/CRR
22
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